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1
Introduction

This chapter includes the following topics:

• About this guide (page 10)

• Safety symbols (page 12)

• System technical support (page 13)
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About this guide
Introduction This topic describes the information that is available in this guide.

In this guide This guide provides information for setting up and running the 
BD FACSVerse™ system with BD FACSuite™ software using a 
typical workflow. The guide includes:

• Introductory information about system hardware and 
components, a basic overview of BD FACSuite software and 
instructions about preparing the system for use.

• Instructions for performing daily quality control, basic 
acquisition, and analysis of flow data using BD FACSuite 
software.

• Instructions for maintaining the system and information about 
the optional BD FACS™ Universal Loader. 

See the BD FACSVerse System Reference for additional topics and 
troubleshooting information.

Additional 
information

In BD FACSuite software, you can use the Help or Reference 
menus to access additional information.

• Click Help to view the BD FACSVerse System Safety and 
Limitations Guide and About FACSuite. Help documents are 
provided in PDF format.

• Click Reference to open the BD FACSVerse System Reference 
in a web browser. 

The BD FACSVerse System Reference is a comprehensive 
collection of information that includes all content from this 
user’s guide and additional concepts, procedures, and reference 
information about the cytometer and BD FACSuite software.
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You can use the table of contents, interactive links, or the 
search tool to locate topics of interest. Search results are 
displayed in a familiar web search format to help you find 
information quickly. 

Use the print tools to print individual topics or to print entire 
sections as formatted PDF files. 

Internet access is not required to access this content.
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Safety symbols
Introduction This topic describes the safety symbols used in this guide. For a 

complete description of all safety hazards, see the BD FACSVerse 
System Safety and Limitations Guide.

Safety symbols The following table lists the safety symbols used in this guide to 
alert you to potential hazards.

Symbol Meaning

Caution alert 

Identifies a hazard or unsafe practice that could result in 
data loss, material damage, minor injury, severe injury, or 
death

Biological hazard

Electrical hazard

Laser hazard

Fire hazard

Mechanical hazard, pinch points
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System technical support
Introduction This topic describes how to obtain assistance from BD Biosciences 

technical support.

Before contacting 
technical support

Try the following options for answering technical questions and 
solving problems:

• Read the section of this guide specific to the operation you are 
performing. 

• Read topics of related information which are listed in the More 
Information section (at the bottom of each topic).

• Search the BD FACSVerse System Reference for a specific 
topic. 

Contacting 
technical support

To contact customer support:

1. Go to www.bdbiosciences.com.

2. Select your region. 

3. Click the Support link for details for your local region. 

When contacting BD Biosciences, have the following information 
available:

• System health report that includes the product name, part 
number, and serial number, and details of recent system 
performance. 

• Any error messages

More information • About this guide (page 10)

• See topics about generating a system health report in the 
BD FACSVerse System Reference.

http://www.bdbiosciences.com
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2
About the system

This chapter includes the following topics:

• System overview (page 16)

• Cytometer overview (page 19)

• Optical components (page 22)

• Fluidics components (page 24)

• System options and upgrades (page 26)

• BD FACSuite software overview (page 28)

• BD FACSuite software components (page 31)

• Daily workflow (page 36)
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System overview
Introduction This topic gives an overview of the BD FACSVerse system and 

provides a description of the main components. 

About the system The BD FACSVerse system includes the BD FACSVerse cytometer, 
the optional BD FACS Universal Loader, and BD FACSuite 
software running on the system workstation. The system also 
includes customized setup beads. All of these components combine 
to create an integrated system designed for use in a wide variety 
multicolor research applications. 

The BD FACSVerse flow cytometry system acquires and analyzes 
particles or cells in a liquid suspension. Antibodies to specific cell 
proteins are labeled with a fluorescent dye and incubated with the 
cell suspension. The suspension flows through the cytometer and is 
interrogated by a laser which excites the fluorescent antibodies. 
The fluorescence is captured and the resulting data is analyzed to 
reveal information about the cells. Multiple antibodies, each 
labeled with a different dye, can be used in a single tube to 
simultaneously identify different cell populations. This technique 
can be used in diverse research areas such as stem cell 
development, cell signaling pathways, and HIV.

Waste 
tank

BD FACSVerse 
cytometer

BD FACS 
Universal Loader 
(optional)

Workstation with 
BD FACSuite 
software

Sheath 
tank

BD FACSuite 
CS&T research 
beads 
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BD FACSuite software is used to operate the instrument, acquire 
samples, and analyze the data. Quality control performance, 
tracking, and reporting are streamlined and automated. Routine 
tasks such as daily cleaning and shutdown can be programmed to 
occur automatically. Select from a variety of pre-defined research 
assay modules to quickly create experiments using existing BD 
reagent kits. The modular design of the software allows you to 
analyze data as samples are being acquired.

BD FACSVerse 
cytometer

The BD FACSVerse cytometer is a compact research flow 
cytometer. Several hardware options and upgrades can be used to 
customize the system for different applications. 

The vacuum-driven fluidics along with a uniquely designed flow 
cell and sample injection tube provide reliability and good signal 
resolution. In addition to standard high, medium, and low flow 
rates, a special high-sensitivity fluidics mode makes it easier to 
detect dimly stained particles.

Three laser configurations provide the ability to analyze up to 8 
colors (10 parameters). A unique heptagon detector array takes the 
guesswork out of changing filters and ensures that the correct 
filters and mirrors are installed.

BD FACS Universal 
Loader

The Loader is an optional automated loading system that delivers 
samples to the BD FACSVerse cytometer for acquisition. It is 
designed for walkaway operation.

The Loader offers various settings to resuspend and mix samples. 
It has the flexibility to draw from 12 x 75-mm tubes in 30- and 40-
tube racks, and multiple types of microtiter plates, including deep-
well plates. A barcode reader verifies the ID on tube racks, plates, 
and individual tubes. A built-in imaging system provides safety 
checks, such as verifying the correct rack type and tube 
orientation, and ensuring that tubes and plates were loaded 
correctly.
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Workstation The system is shipped with a workstation that includes a monitor, 
keyboard, and mouse. The workstation runs BD FACSuite 
software and other applications and controls the cytometer. The 
workstation comes equipped with these items:

• Microsoft® Windows® 7 operating system

• BD FACSuite software version 1.0 or later

The workstation requires a security key that plugs into a USB port 
to run the software.

Sheath and waste 
tanks

Several tank sizes are available depending on the sample 
throughput and needs of the individual laboratories. The standard 
5-L capacity sheath and waste tanks are located to the left side of 
the cytometer in a dock. The dock can be disconnected from the 
cytometer. Optional 10-L extended-use tanks are also available. 
Level sensors alert you when fluid levels are low (sheath) or high 
(waste). Additionally, for high-volume labs, a BD FACSFlow 
cubitaner can be used to supply sheath fluid.

For more information on fluidics tank options, see System options 
and upgrades (page 26). 

Beads, reagents, 
and assays

BD FACSuite CS&T research beads are used to check the 
cytometer performance and automatically make adjustments, 
ensuring consistent values from day to day and experiment to 
experiment. 

BD FACSuite FC beads are used to set up compensation controls 
which are valid for 30 days.

BD research assays are available as predefined modules that can be 
used with standard BD reagents to support a wide range of 
applications. Worksheets with plots and gates are already set up 
for acquisition and analysis. The research assays can also be used 
as a starting point for creating customized experiments and assays.
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More information • Cytometer overview (page 19)

• System options and upgrades (page 26)

• BD FACSuite software overview (page 28)

Cytometer overview
Introduction This topic describes the main components of the BD FACSVerse 

cytometer, the location and functions of the status indicators, and 
the available cytometer configurations.

Main components The locations of the main components of the cytometer, including 
the status indicators, are shown in the following figure.

Cytometer power 
button

Fluidics status 
indicator

Acquisition status 
indicator

Manual tube port 

Heptagon 
detector arrays, 
behind front door

Cytometer status 
indicator

Connector panel 

Ethernet 
connector for 
workstation

AC power 
circuit breaker

SIT door

Access door for 
sheath filter on 
left side of 
cytometer
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Status indicators When the system is started, status indicators display different 
conditions to indicate the system’s status. The functions of the 
status indicators are described in the following table.

Indicator Condition Status

Cytometer status Green Ready for operation

Solid amber Fault condition

Blinking amber Warming up

Red System inoperable

Cytometer power 
button

Amber Power is off to all major 
subsystems

Green Power is on

Blinking green Shutdown process has 
started

Acquisition status Off Not previewing or acquiring 
sample

Blinking blue Previewing or acquiring 
sample

Fluidics status Off Ready

Blinking amber  Sheath fluid low

 Waste tank almost full

Red  Sheath fluid empty

 Waste tank full

 Waste tank disconnected
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Cytometer 
configurations

The BD FACSVerse system is available in the following 
configurations.

More information • Optical components (page 22)

• Fluidics components (page 24)

• System options and upgrades (page 26)

• BD FACSuite software overview (page 28)

Lasers Number of colors 

1 laser (blue) 4-color (4-0-0)

2 lasers (blue, red) 6-color (4-2-0)

3 lasers (blue, red, violet) 8-color (4-2-2)
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Optical components
Introduction This topic describes the optical components, including the 

heptagon detectors and the filter holders.

Location of optical 
components

The optical compartment is located on the front of the cytometer, 
behind the front door. The heptagon arrays for each laser are 
accessible when the door is open. The following figure shows the 
locations of the optical components.

Heptagon detector 
arrays

The heptagon detector arrays contain the filters, mirrors, and 
photomultiplier tubes (PMTs) for each laser. There is a separate 
heptagon for each laser.

Front door in 
open position

Heptagon detectors, 
one for each laser

Red 640 nm

Blue 488 nm

Violet 405 nm
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Filter holders Each channel in a detector array has a removable filter holder that 
contains a bandpass filter and a mirror for that channel. The filter 
holder has an ID chip that identifies the holder to the system so the 
software can confirm that the correct filter holder is in place.

The following figure shows a heptagon and a filter holder.

Location of lasers The system lasers and beam-steering optical components are 
located at the top of the cytometer, under the top cover. There is no 
user access to the laser area.

More information • Fluidics components (page 24)

• System options and upgrades (page 26)

• See topics on laser configurations and optical specifications in 
the BD FACSVerse System Reference.

Heptagon

Filter holder

Handle

ID chip
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Fluidics components
Introduction This topic describes the main fluidics components of the 

BD FACSVerse system.

Manual tube port The manual tube port is located on the right front of the cytometer. 
A circular LED indicator at the base of the port turns green when 
the system is ready to accept a tube. 

The following figure shows the manual tube port.

The following table describes the conditions and status of the 
manual tube port indicator.

Sample injection 
tube (SIT)

The sample injection tube (SIT) is the tube that aspirates sample 
from a tube or a well and delivers it to the flow cell. 

Condition Status

Solid green Ready to accept a tube

Blinking amber SIT flush in progress, do not load 
a tube

Off Tube is loaded

Manual tube port

Tube loaded on port

LED status indicator
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Qualified tubes Only the following tubes have been qualified for use on the manual 
tube port on the cytometer.

For information on BD part numbers for tubes, see the 
BD FACSVerse section of the BD Biosciences website.

Tube adapters You can use 15-mL, 50-mL, and Eppendorf 2-mL tubes by installing 
a tube adapter. The 15-mL and 50-mL adapters screw onto the top 
of the tubes. The Eppendorf adapter slides onto the tube from the 
side.

Tube type
Maximum 
volume

BD Falcon™ 5 mL (12 x 75-mm) polystyrenea

a. For optimal performance in reducing carryover, fill to 0.5 mL or
less, so the wash probe does not contact sample.

2 mL

BD Falcon 5 mL (12 x 75-mm) polypropylenea 2 mL

BD Trucount™ 5 mL (12 x 75-mm)a 2 mL

BD Falcon 15 mL (when used with adapter) 14 mL

BD Falcon 50 mL (when used with adapter) 45 mL

Eppendorf 2 mL (when used with adapter) 1.5 mL

50-mL adapter 15-mL adapter
Eppendorf 2-mL 
adapter
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Sheath filter The sheath filter is located on the left side of the cytometer behind 
the access door. The sheath filter should be changed every three 
months.

More information • Replacing the sheath filters (page 175)

• System options and upgrades (page 26)

System options and upgrades
Introduction This topic describes the BD FACSVerse system options and 

available upgrades.

Category Option Description

System 
hardware

BD FACS Universal 
Loader

The Loader is an optional automated loading system 
that mixes samples and delivers tube racks and plates 
to the BD FACSVerse system for acquisition. 

See BD FACS Universal Loader overview (page 150).

Handheld barcode 
reader

The handheld barcode reader plugs into the USB port 
on the system computer workstation and reads most 
current barcode standards. 

See the topic about the barcode reader in the 
BD FACSVerse System Reference.

BD Flow Sensor The optional Flow Sensor provides quick and 
accurate volume measurements for determining cell 
counts in a sample at medium and high flow rates. 

See topics about the Flow Sensor in the 
BD FACSVerse System Reference.

Optics Laser upgrades Upgrade a 1-laser system to a 2-laser or 3-laser 
system. These upgrades can be done at the customer 
site.
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Fluidics Large fluidics tanks 
(10-L capacity)

The optional large volume sheath and waste tanks 
have a 10-L capacity. These tanks do not have a dock 
and are normally stored on the floor. 

See topics about the fluidics tank options in the 
BD FACSVerse System Reference.

Cubitainer Sheath fluid can also be supplied from a 
BD FACSFlow cubitainer by using an optional 
adapter. 

Applications 
and assays

FCAP Array™ 
software version 3.0 

FCAP Array software facilitates the data analysis of 
bead assays. These assays can detect the presence of, 
or determine concentrations for, multiple analytes 
(for example, proteins and peptides) in a sample.

BD Assurity Linc™ 
software

BD Assurity Linc software is a highly secure remote 
systems management service that connects BD 
instruments and BD technical support personnel. 
Using the BD Assurity Linc Agent, BD support 
personnel can securely access your workstation 
through an enterprise server and diagnose problems 
remotely. 

See the topic about BD Assurity Linc software in the 
BD FACSVerse System Reference.

BD assays Contact your BD representative for a current list of 
available BD assays.

Category Option Description
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BD FACSuite software overview
Introduction This topic provides an overview of the basic features and 

functionality of BD FACSuite software. BD FACSuite integrated 
multicolor flow cytometry software controls the BD FACSVerse 
cytometer and the optional BD FACS™ Universal Loader.

General software 
features

BD FACSuite software provides tools for data acquisition and 
analysis, and advanced setup and QC tools to maintain peak 
system performance. Using the software, you can customize the 
system hardware configuration and software interface to fit your 
specific workflow and application needs.



Chapter 2: About the system 29

Use BD FACSuite software to build and refine experiments using 
the full array of BD reagents, to create assays from these 
experiments, and then to automatically acquire and analyze 
samples from a list of entries in a worklist. Data can be displayed, 
saved, and exported based on your preferences.

Setup and QC BD FACSuite software provides comprehensive tools to set up the 
cytometer, assays, and experiments and to run QC on a daily basis 
to maintain precise and reproducible results and ensure consistent 
performance.

The setup and QC procedures use BD FACSuite CS&T research 
beads and assays to measure and adjust cytometer PMT voltages. 
This ensures that target values for the cytometer and assays and 
experiments are maintained.

Levey-Jennings charts are generated. Use these charts to track and 
set acceptance criteria for various performance parameters. Use 
generated QC reports to document and track the system 
performance over time.

Experiments and 
assays

In BD FACSuite software, you can measure and analyze samples 
using either assays or experiments. Both formats organize and 
specify the conditions for acquisition and analysis for tubes. 

Use assays when you want to run a specific protocol or analysis on 
samples repeatedly. Assays are run as entries in a worklist, which 
provides batch acquisition and analysis. Use experiments to test 
studies and different samples, and to develop protocols. 
Experiments are exploratory and highly customizable. You can 
define the properties of each tube and create custom tube settings 
and apply them to other tubes. You can refine an experiment and 
then save it as an assay to set the test protocols. 
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While assay protocols are pre-defined to target specific data 
(markers, populations, fluorochromes, etc) and look for specific 
results, you can modify plots, gates, and other worksheet or report 
elements. Worklists provide administrative control capabilities 
such as e-signature and audit trails. BD FACSuite software runs 
both BD-defined and user-defined assays. 

In experiments, data can be displayed in a worksheet or report 
using any combination of plots or histograms. In BD FACSuite 
software, worksheets and reports are live data portals and 
continuously display current data. You can acquire data and then 
analyze it by gating populations of interest, displaying statistics, 
and adding expressions. You can create custom, formatted reports 
that include the details you want to analyze and present in a final 
lab report.

Worklist The worklist is a list of tasks to be performed. It organizes multiple 
entries, which include tubes, tasks, status, and other information 
about the sample. Each entry task includes an assay or fluidics 
(cleaning or maintenance) procedure. 

Using the worklist, you can acquire entries, display acquisition 
data, perform analysis on the acquired entries, and export data 
automatically based on your preferences. 

With the BD FACS Universal Loader option, you can load tube 
racks or plates and run worklists in a more automated manner. 

Library The library stores and manages shared resources and assay 
properties. Resources include assays, beads, reagents, keywords, 
labels, and tube settings. You can import, add, and delete all 
resources. You can also edit keywords and assay properties.

Resources are used as elements in experiments, worklists, and 
setup and QC. For example, you can assign a tube setting to an 
experiment, or a keyword to an entry in a worklist.
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BD FACSuite software components
Introduction This topic describes the components of BD FACSuite software 

windows and describes the menus, and shortcuts you can use to 
navigate the software and perform tasks. 

Window 
components

The BD FACSuite windows consist of the following components.

 

• Title bar. Displays the BD FACSuite software product name 
and the standard window controls (minimize, maximize, 
close).

Navigation bar Status barPanels

WorkspaceTitle bar Menu bar Message bar
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• Menu bar. Displays the following software menus.

• Message bar.  Located at the top of the window (below the 
Menu bar) and displays system messages. 

• Workspaces. Contain the panels, fields, tables, and tools 
required for a specific function. Individual workspaces are 
provided for setup and QC, experiments, worklists, and the 
library. 

• Navigation bar. Located at the left side of the window. Click 
the navigation bar icons to open the different workspaces. 

Menu Description

File This menu includes specific tools and items for the current window or 
workspace. Choices include importing, exporting, printing, saving, and 
managing specific workspaces (for example, creating a new experiment, 
opening a worklist).

Edit This menu includes Cut, Copy, Paste, Delete, Undo, Redo, and other 
editing tools.

View This menu includes display control items.

Tools This menu includes user management, preferences, administration, 
tracking, and setup items.

Cytometer This menu includes cytometer cleaning, information, and control items.

Help This menu includes documentation in PDF format and basic software 
information.

Reference This menu includes the BD FACSVerse System Reference. Use the 
BD FACSVerse System Reference to view and search for information on 
using the system.

User profile 
(username)

This menu item opens the My Profile dialog. Use this dialog to manage 
your login password and user profile information.

Preferences This menu item opens the Preferences dialog. Use this dialog to set 
default system preferences.

Logout This menu item log the current user out of BD FACSuite software.
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• Panels. Contain the tools, fields, and options for performing 
specific and detailed functions required for a workspace. You 
can maximize, minimize, or reposition panels on the screen. 

• Status bar. Located at the bottom of the window and displays 
the current cytometer connection status, fluidics status, and an 
acquisition progress bar.

About the Home 
page

The Home page is the default starting page. This page includes the 
following sections:

• Quick Start. Displays shortcuts for the most commonly used 
workflows or operations. 

• System Status. Displays the current status and serial numbers 
of the system for the fluidics, lasers, and all system 
components, and the connection status. It also displays all 
installed options.

• BD Assays. Displays the list of currently installed BD-defined 
assays.
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Quick Start 
shortcuts

The following table describes the available Quick Start shortcuts. 

Quick Start System status

BD assays

Shortcut Task Description

 

Setup & QC Opens the Setup & QC workspace 
and displays the Setup & QC tab.

Setup & QC 
Report

Opens the Setup & QC workspace 
and displays the QC Report tab.

QC 
Tracking

Opens the Setup & QC workspace 
and displays the QC Tracking tab.
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More information • System overview (page 16)

• Daily workflow (page 36)

• About this guide (page 10)

Acquire 
Data in 
Worklist

Opens the Experiment workspace 
and displays a new experiment.

Acquire 
Data in 
Worklist

Opens the Worklists workspace and 
displays a new worklist.

Analyze 
Data in 
Experiment

Opens the Experiment workspace 
and displays the Experiment 
Management tab.

Analyze 
Data in 
Worklist

Opens the Worklists workspace and 
displays the Worklists Management 
tab.

Manage 
Library

Opens the Library workspace and 
displays the categories of library 
resources.

Manage 
Users

(Administrators only) Opens the 
User Management dialog and 
displays the list of users.

Shortcut Task Description
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Daily workflow
The following diagram shows the typical daily workflow for the 
BD FACSVerse system.

More information • System setup (page 37)

• System startup and shutdown (page 59)

• Daily setup and QC (page 65)

• Experiment acquisition and analysis (page 77)

• Worklist acquisition and analysis (page 115)

• Maintenance (page 165)

Shut down
the system

Worklist

Experiment

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data

Acquire data Analyze data
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System setup

This chapter includes the following topics:

• Setting up the system (page 38)

• Managing user accounts (page 42)

• Managing departments (page 43)

• Managing users (page 45)

• BD FACSuite preferences (page 48)

• Setup and QC overview (page 50)

• Importing or adding a CS&T bead lot (page 53)

• About setup and QC reports (page 54)
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Setting up the system
Introduction This topic describes system setup and the setup tasks you can 

perform after system installation and configuration.   

About system setup Initial system installation and configuration are performed by your 
BD Service representative. After installation, the CS&T bead lot is 
imported, the system is characterized (characterization QC), and 
the default tube settings and references settings are created. A 
default administrator user account allows complete administrative 
access to your system. 

BD FACSuite software includes default user accounts and 
preferences. You can operate the system using these default user 
accounts and preferences, or you can add user accounts (as needed) 
and modify preferences to suit your specific needs.

Setup tasks Although you can perform many setup tasks in any order (as 
needed), the following tables describe the setup tasks and when 
they should be performed.
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Initial setup tasks 
(performed after 
installation)

These tasks are typically performed after installation. Most tasks 
can also be performed at any time as needed.

Task Purpose Who For more information

Import a CS&T 
bead lot 

Add a CS&T bead lot for a new 
installation, or replaces an 
expiring bead lot file.

This is typically performed after 
installation, then whenever 
bead lots expire.

All users See Importing or 
adding a CS&T bead 
lot (page 53).

Run 
characterization 
QC

Establish a system baseline.

This is typically performed after 
installation, then every six 
months.

Administrator 
only

See topics about 
running 
characterization QC 
in the BD FACSVerse 
System Reference.

Set 
administration 
preferences

Control connected systems and 
software, and generates a 
system health report.

This is typically performed after 
installation, but it can be 
performed at any time as 
needed.

Administrator 
only

See topics about 
administrator 
preferences in the 
BD FACSVerse 
System Reference.

Manage users Adds user accounts or manages 
users and passwords.

This is typically performed after 
installation, but it can be 
performed at any time as 
needed.

Administrator 
only

See Managing user 
accounts (page 42).
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Daily setup tasks These tasks should be performed daily in the following order.

Periodic setup 
tasks

These tasks can be performed as needed.

Task Purpose Who For more information

Run 
performance 
QC

Measure daily system 
performance.

These tasks should be 
performed daily, and as needed.

All users See Running daily 
performance QC 
(page 71).

Run assay and 
tube setup

Prepare the system for daily 
use.

These tasks should be 
performed daily, and as needed.

All users See Running Assay 
and Tube Settings 
Setup (page 73).

Task Purpose Who For more information

Import a CS&T 
bead lot

Add a CS&T bead lot for a new 
installation, or replaces an 
expiring bead lot file.

This is typically performed after 
installation, then whenever 
bead lots expire.

All users See Importing or 
adding a CS&T bead 
lot (page 53).

Run 
characterization 
QC

Establish a system baseline.

This is typically performed after 
installation, then every six 
months.

Administrator 
only

See topics about 
running 
characterization QC in 
the BD FACSVerse 
System Reference.

Manage users Adds user accounts or manages 
users and passwords.

This is typically performed after 
installation, but it can be 
performed at any time as 
needed.

Administrator 
only

See Managing user 
accounts (page 42).
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More information • Setup and QC overview (page 50)

• See topics about tube and reference settings in the 
BD FACSVerse System Reference.

Set preferences Define how the system 
operates, displays, and 
organizes data.

This can be performed at any 
time.

All users See topics about 
preferences in the 
BD FACSVerse System 
Reference.

View the system 
optical 
configuration

Display the current laser, 
mirror, and filters.

This can be performed at any 
time.

All users See topics about 
cytometer 
configurations in the 
BD FACSVerse System 
Reference.

View setup and 
QC reports

Display setup and QC results.

This can be performed at any 
time.

All users See About setup and 
QC reports (page 54).

Set up and view 
Levey-Jennings 
reports

Determine how performance is 
tracked over time.

This can be performed at any 
time.

All users See topics about QC 
tracking in the 
BD FACSVerse System 
Reference.

Manage My 
Profile

Manage your user profile and 
password.

This can be performed at any 
time.

All users See topics about 
managing my profile 
in the BD FACSVerse 
System Reference.

Task Purpose Who For more information
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Managing user accounts
Introduction This topic describes the user management tools in BD FACSuite 

software.

Administrators can use the User Management window to create 
and manage user accounts in BD FACSuite software, as well as 
manage and assign corresponding departments to user accounts 
and create passwords. 

User account types BD FACSuite software includes the following default user 
accounts: 

• Administrator. This account can administer and manage all 
accounts (except BD Service) and has complete access to 
administrator and operator accounts.

• Operator. This account can only administer its own profile 
with certain limitations. 

See topics about managing a profile in the BD FACSVerse 
System Reference.

About the User 
Management 
window

The User Management window can be accessed only by 
Administrator user accounts. The window is divided into two 
panels: a Master panel that displays a table of current users and 
user information, and a Details panel for creating or editing 
information about the user.

User management 
tasks

The following table lists the user management tasks. 

To... See...

Add or edit the department 
that is associated to a user. 

Managing departments (page 43) 

Add or edit user profiles. Managing users (page 45) 
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More information • Setting up the system (page 38)

• See topics about setting administration preferences in the 
BD FACSVerse System Reference.

Managing departments
Introduction This topic describes how to manage departments by adding, 

editing, and deleting their information. 

Departments must be created before you can assign users. This is 
an Administrator task.

Adding new 
departments

To add a new department:

1. From the menu bar, select Tools > User Management. 

The User Management panel opens. 

2. In the Departments tab, click New. 

The New Department detail panel displays at the bottom of 
the tab.

3. Enter values in all required (pink) fields and optional fields, as 
needed. 

All values are alphanumeric text. All fields have a 30-character 
limit, except the Address field, which has a 40-character limit 
and the URL field, which has a 200-character limit. 

Set the password policy for 
your users.

Topics about setting user login and 
password policies in the 
BD FACSVerse System Reference. 

Export or import user 
accounts. 

Topics about importing and 
exporting users in the 
BD FACSVerse System Reference 

To... See...
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4. (Optional) Add a custom department field if needed.

a. Click the Settings tab. 

b. Under Custom Department Fields, click in a field and type 
a category (for example, Supervisor).

c. Click the Department tab. 

The new department field is displayed in the Department detail 
panel.

5. Click Done to add the new department settings to the table.

Editing 
departments

To edit a department:

1. In the Departments tab, select a department to edit.

The Department detail panel displays at the bottom of the tab.

2. Click Edit.

3. Edit the information as necessary. 

4. Click Done. 

Deleting a 
department

To delete a department:

1. In the Departments tab, select the department to delete. 

You can delete only one department at a time. Departments 
containing user accounts cannot be deleted.

2. Click Delete. 

The Delete Department dialog opens.

3. Click Yes to confirm the deletion. 

The department is deleted.

More information • Managing user accounts (page 42)

• Managing users (page 45)
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Managing users
Introduction This topic describes how Administrators can add a new user in 

BD FACSuite software and edit their information later.

Users must be assigned to a department in an institution. The value 
for the department can be None. 

Adding a new user To add a new user:

1. From the menu bar, select Tools > User Management. 

2. In the Users tab, click New.

The User detail panel opens at the bottom of the tab.

Several fields in this panel use pre-defined values from other 
tabs in the User Management window (Departments, 
Passwords, and Roles). 

3. Enter values for all required (pink) fields, and the optional 
fields as needed. 

Values are alphanumeric text. 

In the field... Enter the value for...

First Name 
(Required)

First name for the user (120 characters).

Last Name 
(Required)

Last name for the user (120 characters).

User ID 
(Required)

A user ID for the user (125 characters).

Title A work title for the user (130 characters).

Status A status for the user:

 Active. For users who are granted access to BD FACSuite software.

 Inactive. For users who are no longer granted access to the software.

 Locked. For active users with expired passwords, or users who have 
exceeded the maximum number of failed login attempts.
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Department 
(Required)

A department for the user, as defined in the Departments tab. The value 
can be None. 

Institution 
(Required)

An institution for the user, as defined in the Departments tab. If the 
Department value is None, then the Institution value is None. 

Email An email address for the user (must be 1–60 characters and include the @ 
symbol).

Role A role for the user (for example, Administrator or Operator (default)). 

Password 
Expiration Date

The date that the user password expires (for example, Password 
Expiration Date = today's date + Password Expiration Days). Password 
details are defined in the Settings tab.

Phone A phone number for the user.

Temporary 
Password 
(Required) 

A temporary (initial login) password. Administrators can type specific 
passwords (case-sensitive, 4–16 characters, no spaces), or generate a 
random password by clicking Generate Password. 

At first login, the user is prompted to enter a new password.

Notes Any notes to document history, or other descriptions of the new user 
(maximum of 250 characters). 

In the field... Enter the value for...
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4. (Optional) Add a custom user field if needed.

a. Click the Settings tab. 

b. Under Custom User Profile Fields, click a field and type a 
category (for example, Supervisor).

c. Click the Users tab. 

The new user profile field is displayed in the User detail panel.

5. Click Done to save the new user to the Users table.

Editing user details To edit user details:

1. In the Users tab, select a row in the Users table.

2. Click Edit.

3. Edit the information as needed. 

4. Click Done.

Resetting a user 
password

To reset a user password:

1. In the Users tab, select a row in the Users table.

2. Click Edit.

3. In the User detail panel, click Reset Password to generate a 
random password, or type a new password in the Temporary 
Password field.

4. In the Password Expiration Date field, reset the expiration 
date for the new password.

5. (Optional) Click the Settings tab to view the password policies.

6. Click Done.

Making users 
inactive

To make a user inactive:

1. In the Users tab, select a row in the Users table.

2. Click Edit.
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3. In the User detail panel, select Inactive in the Status menu.

4. Click Done.

The user status becomes inactive in the Users table and access 
is denied.

More information • Managing user accounts (page 42)

• Managing departments (page 43)

BD FACSuite preferences
Introduction This topic describes preferences: what they are and how they are 

managed. 

About preferences Preferences specify administration settings, display options, 
schedules for automatic actions, notifications, and other functions. 
They include settings for the System, Worklist, Experiment, Setup 
& QC, and BD FACS Universal Loader. Once set, preferences 
persist until modified.

All preferences, except system preferences, are specific to a user. 
Changes to system preferences affect all users while changes to 
other preferences affect only the logged-in user and his view. 

The ability to edit preferences is defined by your assigned role. 
Administrators can set and edit preferences for all users but 
operators can set and edit only their user-defined preferences. 
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Preferences The following table describes the various preferences.

More information • See topics about system, setup and QC, experiments, 
worklists, and Loader preferences in the BD FACSVerse 
System Reference.

Preference Description

System These global preferences set system startup and behavior, programmed 
startup and shutdown, and other general system settings. System 
preferences are applied to all users. 

Setup & QC These preferences set automatic printing for Setup and QC reports, 
exported file locations, QC expirations, and QC dot plot parameters 
for specific cytometer configurations. Setup and QC preferences are 
associated to each user ID, so you can customize them without 
affecting other users. 

Experiments These preferences set preview and acquisition auto-start and default 
tube settings. Experiment preferences are associated to each user ID, so 
you can customize them without affecting other users.

Worklist These preferences set the acquisition and report delay timers, define 
exported file names and locations, and set printing options. Worklist 
preferences are associated to each user ID, so you can customize them 
without affecting other users.

Loader These preferences define how samples are loaded and mixed. Loader 
preferences are associated to each user ID, so you can customize them 
without affecting other users.
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Setup and QC overview
Introduction This topic describes periodic and daily setup and quality control 

(QC) procedures for the cytometer. 

Use the Setup & QC workspace to perform these tasks. After you 
perform setup and QC tasks, you can view the results summary in 
the Setup & QC workspace, or view a detailed report of the task.

Pre-requisite tasks The following tasks should be completed before performing setup 
and QC tasks (as needed).

Task Description For more information

Import or add a 
CS&T bead lot

Verify that you have a current (non-expired) 
CS&T bead lot. You must have a current bead 
lot to characterize the system, perform daily 
quality control tasks, and create tube settings 
and reference settings. 

You can import bead lot ID information from 
the BD website or add bead lot ID information 
by scanning the barcode in a kit.

See Importing or 
adding a CS&T bead 
lot (page 53).

Install assays Install BD assays in BD FACSuite software. 
Follow the installation instructions included in 
the technical data sheet.

See System options 
and upgrades 
(page 26).
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Daily setup and QC 
tasks

The following setup and QC tasks should be performed daily.

Setup and QC 
task Description For more information

Performance 
QC

Performance QC is a daily process that utilizes 
a set of automated software functions and 
calculations that measure the daily operating 
efficiency of the cytometer.

See Running daily 
performance QC 
(page 71).

Assay and tube 
settings setup

Assay and tube settings setup is a daily process 
that sets the tube settings and the daily 
performance QC. This task determines the 
correct PMT voltages needed that day for each 
fluorochrome to match median fluorescence 
intensity (MFI) determined by the tube target 
value (TTV) in the tube settings. 

See Running Assay and 
Tube Settings Setup 
(page 73).

See topics about tube 
settings and reference 
settings in the 
BD FACSVerse System 
Reference.
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Periodic setup and 
QC tasks

The following setup and QC tasks should be performed only as 
needed.

More information • About setup and QC reports (page 54)

• See topics about tube settings and reference settings in the 
BD FACSVerse System Reference.

Setup and QC 
task Description For more information

Characterization 
QC

Characterization QC is only available to 
Administrators. This task establishes the 
measured cytometer performance baseline that 
is used for all subsequent performance QC runs. 
Characterization QC is performed at 
installation and every six months. 

See topics about 
characterization QC 
in the BD FACSVerse 
System Reference.

Laser setup Laser setup is only available to Administrators. 
This task initiates an automatic re-alignment of 
the lasers, followed by performance QC to 
update settings. Run this procedure if the laser 
alignment check fails during performance QC, 
or if the % rCV is out of range.

See topics about 
running laser setup in 
the BD FACSVerse 
System Reference.

CS&T bead lot 
transfer

CS&T bead lot transfer transfers the associated 
ABD values from an existing bead lot to a new 
bead lot. This allows use of the tube target 
values and spillover values based on the new 
CS&T bead lot without having to re-
characterize the system. In addition, CS&T 
bead lot transfer transfers the %rCV criteria 
from existing lot to a new lot for automatic laser 
realignment.

See topics about 
transferring CS&T 
bead lots in the 
BD FACSVerse 
System Reference.
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Importing or adding a CS&T bead lot
Introduction This topic describes how to import or add a new CS&T bead lot 

when your existing lot has expired.

You must have a current bead lot to characterize the system, to 
perform daily quality control tasks, and to create tube settings and 
reference settings.

Importing CS&T 
bead lots

Import CS&T bead lots if you do not have the optional barcode 
reader. CS&T bead lot files can be downloaded from the BD 
website. See the information included in the CS&T bead kit for the 
specific URL and instructions for downloading bead lot files.

To import a CS&T bead lot:

1. On the navigation bar, click Library. 

The Library workspace opens.

2. In the Browser, double-click Beads and Reagents, then click 
CS&T. 

The CS&T bead information is displayed in the upper-right 
panel. 

3. From the menu bar, select File > Import. 

The Import dialog opens.

4. Navigate to the CS&T bead lot file location and select the 
appropriate CS&T bead lot file. 

5. Click Open. 

The new bead lot file is displayed in the table. The Import 
confirmation dialog opens if there are warnings or errors. 
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Adding a new CS&T 
bead lot

To add a new CS&T bead lot using the barcode scanner:

1. On the navigation bar, click Library. 

The Library workspace opens.

2. In the Browser, double-click Beads and Reagents, then click 
CS&T. 

3. In the CS&T Bead Lots table, click Scan barcode and scan the 
new bead lot barcode. 

The information is automatically displayed in the CS&T Bead 
Lots table.

More information • Setting up the system (page 38)

• See topics about transferring CS&T bead lots in the 
BD FACSVerse System Reference.

About setup and QC reports
Introduction This topic describes the content of the setup and QC reports. You 

can access these reports in the Setup & QC workspace, in the 
Setup and QC Reports tab.

About setup and 
QC reports

Setup and QC reports contain information about the system, 
detectors settings, lasers, setup bead lots, and cytometer settings. 
They are generated after characterization QC, performance QC, 
and laser setup. Each time a procedure is completed, two reports 
are generated, one for each fluidics mode: normal and high 
sensitivity. Information in the reports varies depending on the 
cytometer being used. 

Viewing a setup 
and QC report

To view a setup and QC report:

1. In the Setup & QC workspace, click the Setup and QC Report 
tab.
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2. In the Report Browser, click the report you want to view.

The following sections describe report details.

System information The top section displays the cytometer type, name, configuration, 
serial number, options, last characterization and QC date, and user 
and institution identity. 

Summary This section displays pass/fail status. Pass status is indicated by the 
word PASSED. Fail status in indicated by the word FAILED. 

Warnings Warnings are displayed when the current values are outside of the 
acceptable range. Red text indicates out-of-range or expired 
values. 

Detector settings QC reports for characterization QC and performance QC are 
different. This table displays information that is displayed in a 
characterization QC report. 

Section or field Description

Parameter Laser power and/or laser current

Value Current value of the parameter

Range Expected value range for the parameter

Message Reason for the warning

Section Field Description

Detector Name Name for the detector

Mirror Name of the mirror used with the detector

Filter Description of wavelengths transmitted

Position Location of the filter holder with mirror 

PMT Voltage Measured PMT voltage
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Laser settings The measurements shown in this section of the report are 
cytometer-dependent.

Slope of Gain Slope of the PMT voltage vs brightness for bright beads 
(log MFI vs log PMT voltages)

Bead (bright, 
mid, or dim)

Median Median fluorescence intensity (MFI) value of the specific 
beads.

%rCV Percent robust coefficient of variation of the bright beads.

Linearity Min 
Channel

Minimum value for the acceptable linear range of the 
detector

Linearity Max 
Channel

Maximum value for the acceptable linear range of the 
detector

Resolution Sensitivity MFI of the bright bead to the two times the standard 
deviation of noise of a given detector. 

Electronic 
noise rSD

Robust standard deviation (rSD) of the electronic noise in 
the particular detector,  used to predict the minimum 
acceptable signal levels required for the best attainable 
resolution and sensitivity for the system

Qr Relative fluorescence detection efficiency, used for 
describing the light collection efficiency of a detector

Br Relative optical background signal, used for tracking the 
optical background noise levels in a detector

Section Field Description

Measurement Description

Laser Laser name

Position Location of each laser

Delay (Trigger on FSC) Laser delay values when thresholding on FSC

Delay (Trigger on 
Fluorescence)

Laser delay values when thresholding on 
fluorescence
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Info This section displays information on the setup beads and the 
cytometer settings that were used. 

Comments The Comments section displays comments that were previously 
added to the report. Click the Comments icon to add a new 
comment to the report. 

Linearity results This section of the report shows linearity plots for each detector.

A detector’s linear range is determined by measuring the MFI ratio 
of bright beads to mid beads across the detector’s dynamic range. 
The ratio values from the middle of the range, which is known to 
be linear, are averaged and compared against individual ratios. If 

Area Scaling Factor Area scaling factors that are determined by 
setting area and height values on the bright 
3-µm beads

Power Actual (mW) Laser power measured in milliwatts

Power Spec (mW) Laser power specification in milliwatts 

Current (mA) Laser current measured in milliamperes

Current Spec (mA) Laser current specification in milliamperes

Measurement Description

Field Description

Bead Lot ID Setup bead identifier on the kit label

Expiration date Date after which the bead activity is not 
guaranteed

Windows extensions The amount of time added to collect the 
signal pulse above the threshold

FSC area scaling factor Area scaling factors that is determined by 
setting the FSC area and height values on the 
bright 3-µm beads
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the difference between the measured ratio and the averaged ratio is 
greater than 2%, the results are not considered linear.

More information • Setup and QC overview (page 50)

• About setup and QC reports (page 54)

• See topics about characterization QC in the BD FACSVerse 
System Reference.



4
System startup and shutdown

This chapter includes the following topics:

• Performing system startup (page 60)

• Performing manual system shutdown (page 61)

• Performing automated system shutdown (page 63)
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Performing system startup

Introduction This topic describes how to perform the normal system startup 
procedure. You can also set up a pre-programmed time and day to 
start the system automatically. 

See topics about setting cytometer schedule preferences in the 
BD FACSVerse System Reference for more information.

Daily consumables The following table describes the required consumables for daily 
operation of the system.

Procedure To start up the system:

1. Turn on the power to the system by pressing the Power button.

The Power button turns green when system power is on. Allow 
20 minutes for the lasers to warm up before starting any 
acquisition work.

2. Log in to BD FACSuite software.

a. Double-click the BD FACSuite icon to start BD FACSuite 
software.

b. Enter a username and password to log in, then click OK.

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system

Item Requirement Supplied by

Bulk fluids  BD FACSFlow sheath solution

 Bleach (for the waste tank)

 Deionized (DI) water 

 BD

 User

 User

Setup beads  BD FACSuite CS&T research beads  BD
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3. Verify that the software is connected to the cytometer by 
looking for the green Connected status icon in the lower-left 
corner of the workspace.

4. Check the fluid levels.

c. Check the sheath tank to ensure that there is enough sheath 
fluid to perform your work.

d. Check the waste tank to ensure there is adequate capacity.

5. Verify that the fluidics system is ready by looking for the green 
Fluidics status icon in the lower-right corner of the workspace.

More information • Refilling the sheath tank (page 168)

• Emptying the waste tank (page 170)

Performing manual system shutdown

Introduction This topic describes the manual system shutdown procedure. Use 
this procedure to manually perform the daily cleaning and 
shutdown of the system.

Alternatively, you can program the system to shut down 
automatically. See Performing automated system shutdown 
(page 63).

Required materials • 1 tube containing 2 mL of 10% bleach solution

• 1 tube containing approximately 3 mL of DI water

• Disposable towels or wipes.

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system
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Shutting down the 
system

To manually shut down the system:

1. From the menu bar, select Cytometer > Daily Clean. 

The Daily Clean dialog opens.

2. Place a tube containing 2 mL of 10% bleach solution on the 
manual tube port, then click Continue.

3. When prompted, place a tube containing approximately 3 mL 
of DI water on the manual tube port, then click Continue.

The dialog closes when the process is complete.

4. Leave a tube containing 2 mL of DI water on the manual tube 
port.

5. Clean external surfaces.

a. (Optional) Wipe down the external surfaces of the 
cytometer and work area.

b. Dispose of the used cleaning materials in biohazard 
containers.

6. From the menu bar, select Cytometer > Shutdown. 

The Cytometer Shutdown dialog opens.

7. Click Yes.

The Power button blinks green for a few seconds, then power 
to the system turns off and the Power button turns amber.

Note that a tube of DI water should be loaded on the manual 
tube port whenever the system is not in use.
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Shutting down the 
software (optional)

If you are using the pre-programmed startup feature, do not 
perform the following steps. The software must remain running to 
enable startup at the defined day and time.

1. Log out of the software.

a. From the right side of the menu bar, click the Log Out 
button.

b. In the confirmation dialog, click Yes.

2. Exit the software. 

c. From the main menu, select File > Exit. 

Performing automated system shutdown

Introduction This topic describes the process for shutting down the system by 
running a worklist on the Loader. 

Automated 
shutdown using the 
worklist

Automate the shutdown process using the worklist by adding 
cleaning and shutdown entries to a worklist and then running that 
worklist using the Loader. 

For this process, you need to prepare a tube with a 2mL of 10% 
bleach solution and a tube containing approximately 3 mL of DI 
water. Place the tubes in a 30- or 40-tube rack (plates cannot be 
used). Next, create new worklist, or open an existing worklist, 
then add cleaning and shutdown entries to the end of the worklist.

For details about creating cleaning and shutdown entries in a 
worklist, see topics on adding fluidics cleaning or shutdown to a 
worklist in the BD FACSVerse System Reference.

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system



BD FACSVerse System User’s Guide64

The following figure shows a sample worklist with cleaning and 
shutdown entries added.

Once the entries are added to a worklist, you can open the worklist 
and run it.

Running an 
automated 
shutdown using a 
worklist

To run an automated shutdown using a worklist:

1. Open the shutdown worklist.

2. Run the worklist.

When the worklist is finished, the system power turns off.

3. Place a tube of DI water on the manual tube port.

Note that a tube containing 2 mL of DI water should be 
loaded on the manual tube port whenever the system is not in 
use.

More information • Acquiring data in a worklist (page 133)



5
Daily setup and QC

This chapter includes the following topics:

• About the Setup and QC workspace (page 66)

• Daily setup and QC workflow (page 70)

• Running daily performance QC (page 71)

• Running Assay and Tube Settings Setup (page 73)
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About the Setup and QC workspace
Introduction This topic describes the tabs in the Setup and QC workspace. 

The Setup and QC workspace includes multiple tabs that you use 
to perform different setup and quality control tasks, view reports, 
track QC over time, and view or modify the cytometer optical 
configuration.

To open the Setup and QC workspace, click Setup & QC on the 
navigation bar.

Setup & QC tab The Setup and QC tab includes the following panels:

• Setup & QC Options. Use this panel to select setup and QC 
tasks, select CS&T bead lots, and start or abort setup and QC 
operations.

• Cytometer. This panel displays the current cytometer 
configuration and the current cytometer status. Status displays 
the system status (including real-time status for the SIT), 
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fluidics, and lasers. This box also reminds you when you need 
to run system cleaning protocols.

You can click the arrow icon in the Status title bar to expand 
or collapse this section.

• Setup Tasks. This panel displays real-time status of setup and 
QC task steps. Green checkmarks indicate completed steps. 



BD FACSVerse System User’s Guide68

Setup and QC 
Reports tab

In the Setup and QC Reports tab, the Reports Browser table lists 
all of the reports that are generated when you perform a 
characterization, performance, or laser setup QC task. Separate 
reports for each fluidics mode (normal and high sensitivity) are 
generated for each setup and QC task. 

Reports contain details about the system, detector settings, lasers, 
setup bead lots, and cytometer settings. Click a report in the table 
to view, print, or export the report. 

QC Tracking tab Use the QC Tracking tab to set the performance values that you 
want to display in Levey-Jennings charts and the alarm ranges and 
scales. Levey-Jennings charts are used to track the instrument 
performance over time.

Assay Setup 
Reports tab

In the Assay Setup Reports tab, the Assay Setup Reports table lists 
all of the reports that are generated when you perform assay and 
tube settings setup. 

Reports contain details about the assay, cytometer configuration, 
setup bead lot, and user. Click a report in the table to view, print, 
or export the report. 
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Configuration tab Use the Configuration tab to view the current cytometer 
configuration and the details for each laser and detector.

You can assign fluorochromes to detectors, and view, print, and 
export configuration reports.

More information • Daily setup and QC workflow (page 70)

• About setup and QC reports (page 54)
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Daily setup and QC workflow

Introduction This topic describes the setup and QC tasks you need to complete 
before you acquire and analyze data using experiments or 
worklists. 

Daily setup and QC 
tasks

Perform the following setup and QC tasks each day.

More information • About the Setup and QC workspace (page 66)

• Setup and QC overview (page 50)

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system

Stage Description

1 Run performance QC to measure the daily operating 
efficiency of the cytometer.

See Running daily performance QC (page 71).

2 Run Assay and Tube settings setup to determine the PMT 
voltages needed to meet the median fluorescence 
determined by the tube target values in the tube settings. 

See Running Assay and Tube Settings Setup (page 73).
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Running daily performance QC
Introduction This topic describes how to run daily performance QC in the Setup 

& QC workspace.

A typical performance QC should take approximately 10 minutes 
if the CS&T beads have already been prepared.

Before you begin • Prepare a tube with BD FACSuite Research CS&T beads 
according to the directions in the technical data sheet.

• If you are planning to run QC with a new bead lot, add the 
new bead lot to the library first. 

Procedure To run daily performance QC:

1. On the navigation bar, click Setup & QC.

The Setup & QC workspace opens.

2. In the Setup & QC Options panel, verify that Performance QC 
is selected. 

3. Verify that the correct CS&T bead lot ID is selected. 

4. Click Start. 

The Load Tube dialog opens. 

5. Load the tube of CS&T beads onto the manual tube port. 

The system detects the tube and setup task begins.
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The details for normal and high sensitivity fluidics modes are 
displayed in the Setup Tasks panel. A checkmark indicates that 
a step in the task has been completed.

When all tasks are complete a dialog opens and indicates 
whether the task passed or failed.

6. Click Yes to view the report for the QC task or click No to 
close the dialog.

7. Unload the tube.

Next step Running Assay and Tube Settings Setup (page 73)
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More information • Setup and QC overview (page 50)

• Viewing a setup and QC report (page 54)

• About the Setup and QC workspace (page 66)

• Daily setup and QC workflow (page 70)

• Importing or adding a CS&T bead lot (page 53)

Running Assay and Tube Settings Setup 
Introduction This topic describes how to run daily assay and tube settings setup 

in the Setup & QC workspace.

Daily assay and tube settings setup is used to ensure that assays 
and experiments run properly. Use this procedure to select the 
assays and tube settings that you want to update for use today.

Before you begin Run daily performance QC.

Procedure To run assay and tube settings setup:

1. On the navigation bar, click Setup & QC.

The Setup & QC workspace opens.

2. In the Setup & QC Options panel, select Assay & Tube 
Settings Setup. 

3. Click Select.

The Assays and Tube Settings tabs open in the right panel. 

4. In the Assays tab, from the Assays list, select the checkboxes 
for the assays that you want to set up or select the checkbox in 
the header row to select all assays.
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Selecting an assay automatically selects the appropriate tube 
settings.

5. If you want to update a different tube setting, click the Tube 
Settings tab and select a checkbox. 

Note that if you run performance QC, the lyse/wash and lyse/
no-wash tube settings are automatically updated.

6. In the Setup & QC Options panel, click Start. 

The Load Tube dialog opens. 

7. Load the tube of CS&T research beads. 

The system detects the tube and setup task begins.
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The details for normal and high sensitivity fluidics modes are 
displayed in the Setup Tasks panel. A checkmark indicates that 
a step in the task has been completed.

When all tasks are complete, a dialog opens and indicates 
whether the task passed or failed. 

8. Click Yes to view the report for the QC task, or click No to 
close the dialog.

9. Unload the tube.

The assays that were selected for assay and tube settings setup 
are now displayed on the opening page of the Setup & QC 
workspace with a status of OK.
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More information • About the Setup and QC workspace (page 66)

• Setup and QC overview (page 50)

• About setup and QC reports (page 54)

• Viewing a setup and QC report (page 54)

• Experiment overview (page 78)

• See topics about tube settings in the BD FACSVerse System 
Reference for information about tube settings and how they 
are used to ensure reproducible results.



6
Experiment acquisition and analysis

This chapter includes the following topics:

• Experiment overview (page 78)

• Experiment acquisition workflow (page 81)

• Creating and opening experiments (page 82)

• Using the Experiment tab (page 85)

• Building experiments (page 95)

• Creating tubes (page 96)

• Creating plots in a worksheet (page 98)

• Previewing data in plots (page 100)

• Adjusting the cytometer settings for a tube (page 103)

• Drawing gates in plots (page 104)

• Acquiring data in an experiment (page 107)

• Experiment analysis (page 109)

• Creating experiment analysis reports (page 111)

• Creating a user-defined assay from an experiment (page 112)
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Experiment overview 
Introduction This topic describes experiments, the Experiment workspace, and 

provides typical workflow steps for creating, editing, and saving 
experiments. This basic workflow includes only the basic required 
elements for creating and acquiring data in an experiment using 
BD default settings. 

See topics about managing or working with experiments in the 
BD FACSVerse System Reference for more information about 
optional features and functions.

About the 
Experiment 
workspace

The Experiment workspace includes the Manage Experiments tab 
and Experiment tab which represents an open experiment.

To open the Experiment workspace, click Experiments on the 
navigation bar.
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Use the Manage Experiments tab to create new experiments, 
preview and open existing experiments, organize experiments, 
filter and search for experiments, and share them with other users. 
Use the BD FACSuite menus to rename, import, or export 
experiments.

Manage Experiments tab
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Use the Experiment tab to develop your experiment, adjust 
settings, set properties, acquire and visualize tube data, and 
analyze the data using different analysis tools. A separate tab is 
created for each open experiment.

More information • Using the Experiment tab (page 85)

• Experiment acquisition workflow (page 81)

• See topics about using the Managing Experiments tab in the 
BD FACSVerse System Reference.

Experiment tab
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Experiment acquisition workflow

Introduction This topic describes the typical workflow stages you need to 
complete to build an experiment and acquire data. 

Typical workflow Perform the following typical workflow stages for acquiring data 
in an experiment.

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system

Stage Description 

1 Create a new experiment or open an existing experiment.

See Creating and opening experiments (page 82).

2 Build an experiment.

See Building experiments (page 95).

3 Acquire data.

See Acquiring data in an experiment (page 107).

4 (Optional) Save, export, or print the experiment.

See topics about using the manage experiments tab in the 
BD FACSVerse System Reference.

5 (Optional) Create a user-defined assay from the experiment.

See Creating a user-defined assay from an experiment 
(page 112).
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More information • Daily workflow (page 36)

• Performing system startup (page 60)

• Creating and opening experiments (page 82)

• See topics about managing experiments in the BD FACSVerse 
System Reference.

Creating and opening experiments 
Introduction This topic describes the default experiment folder, how to create a 

new experiment in the Manage Experiments tab, and how to open 
an existing experiment.

About the default 
experiment folder

A default experiment folder is automatically created for each user 
ID. All experiments that you create are stored in the default folder 
associated with your user ID. Within this folder, you can create 
custom subfolders using your own method for storing experiments 
(for example, by category, by date, or by sample). 

See topics about managing experiments in the BD FACSVerse 
System Reference for more information about custom subfolders.

Creating a new 
experiment

To create a new experiment:

1. On the navigation bar, click Experiments.

The Manage Experiments tab opens in the Experiment 
workspace.

2. In the Experiments Browser panel, click your default folder or 
subfolder.

3. Click New.
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A new experiment opens. The new experiment name and 
creation date are displayed in the Experiments Browser, and a 
new tab opens in the Experiment workspace.

Opening an 
existing 
experiment

To open an existing experiment:

1. In the Experiments Browser, click your experiment folder or 
click an experiment subfolder to display the available 
experiments.



BD FACSVerse System User’s Guide84

2. (Optional) Click an experiment to display a snapshot of the 
experiment in the Experiment Preview panel.

3. Double-click an experiment to open the experiment in the 
Experiment workspace.

Next steps • If you want to create new tubes or delete existing tubes in your 
experiment, continue with Creating tubes (page 96).

• If your experiment has the correct tubes, plots, gates and 
properties, you can acquire tubes, re-acquire existing tubes, or 
analyze the data. See Acquiring data in an experiment 
(page 107).

More information • Using the Experiment tab (page 85)

• See topics about managing experiments in the BD FACSVerse 
System Reference for information about renaming folders and 
deleting and sharing experiments.

Experiment preview
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Using the Experiment tab
Introduction This topic describes the different panels in the Experiment tab and 

how to use them to build, modify, and run experiments.

About the 
Experiment tab 

When you create a new experiment or open an existing experiment 
in the Manage Experiments tab, a new Experiment tab opens. The 
Experiment tab represents an experiment and includes the 
following panels:

• Acquisition Status

• Data Sources

• Cytometer Settings

• Worksheets and reports 

You can drag the panels to organize them in any order within 
the workspace, or click to minimize panels to maximize 
display space.

Data Sources panel Worksheet

Cytometer Settings panel
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About the 
Acquisition Status 
panel

Use the Acquisition Status panel to view real-time status for time, 
event counts, and aborts. You can also set flow rate and SIT flush 
options specific to an acquisition.

This panel is open by default. You can show or hide this panel. 
When you hide (close) the panel, an Acquisition Status button is 
displayed in a toolbar at the top of the Experiment tab. Click the 
button to display the panel.

Acquisition data displays each time you preview or acquire data. 
The display is refreshed (cleared) each time you preview or acquire 
a tube. You can also click to expand Advanced Status to display 
the acquisition abort count and abort rate.
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You can select the following options in this panel.

These settings are applied to all subsequent tubes in an experiment 
unless you change them.

Option Description

Flow rate Select the rate (low, medium, or high) that the sample flows through 
the flow cell in the instrument. High and medium flow rates are 
typically used for immunophenotyping experiments and to increase 
event throughput. Lower flow rates are typically used when high 
precision is required (for example, DNA experiments) to measure 
slight variations in fluorescence.

The fluidic mode (normal or high-sensitivity) varies the speed that the 
sheath and sample passes through the flow cell in the instrument. The 
high-sensitivity fluidics mode slows the sample and sheath flow, and 
is used to obtain better separation between the negative and positive 
fluorescence populations. 

Events to display Select the maximum number of events to display in plots.

SIT flush The SIT Flush checkbox is selected by default to perform one SIT 
flush after the acquisition completes and after you remove the tube 
from the manual tube port. Increase the number of flushes when 
extra cleaning is required between acquisitions to reduce sample 
carryover.

To specify a different number of SIT flushes:

1. In the list, select the number of times you want to flush the SIT 
(1–6).
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About the Data 
Sources panel

Use the Data Sources panel to add and delete tubes and FCS files 
for acquisition and analysis. You can right-click tubes to set tube 
properties, duplicate tubes, create tube settings, and create or 
update reference settings. The run pointer indicates which tube is 
being previewed or acquired, and which tube’s data is applied to a 
plot.

The Data Sources table displays the tube name, sample ID, and 
acquisition date. The following table describes the buttons in the 
Data Sources panel.

Run pointer

Button Description

New Tube Click to add a new tube to the list.

A new default tube has the default lyse/wash (LW), lyse/no-wash (LNW) 
properties (based on the cytometer optical configuration and experiment 
preferences). 

Lyse/wash provides a starting point for the majority of sample types.

Lyse/no-wash provides a starting point for lysed whole blood prepared 
using a no-wash method.

Import FCS Files Click to display a dialog where you can select FCS files to import files for 
analysis.

Delete Tube Click a tube in the list, then click this button to delete the tube.

Add From 
Worklist

Click to select tubes from a worklist and add them as tubes in an 
experiment. 

See Adding tubes from entries in a worklist (page 96).
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About the 
Cytometer Settings 
panel

Use the Cytometer Settings panel to view system status, run 
cleaning protocols, adjust PMT voltages, and view laser delay and 
area scaling. This panel includes the following sections:

• Status

• PMT Voltages

• Lasers

Preview Click to start the sample flow and to populate plots with event data. This 
does not record event data.

Acquire Click to start the sample flow and record event data to an FCS file.

Stop Click to stop the sample flow and the current preview or acquisition.

Next Click to set the run pointer to the next tube in the Data Sources table. You 
can also click this button to add tubes. 

See Adding tubes using the Next button (page 97).

Pause Click during preview to pause the sample flow and event counters and 
timers.

Resume Click to resume a paused preview.

Restart During preview, click to clear the counters and timers. This clears the 
acquisition data without pausing the fluid flow.

During acquisition, click to delete acquired events, clear counters and 
timers, and clear the progress bar. This clears the acquisition data without 
pausing the fluid flow.

Button Description
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Status The Status section displays the system status, including real-time 
status for the SIT, fluidics, and lasers. This section also indicates 
when you need to run system cleaning protocols.

A checkmark indicates a Ready status. You can click the arrow 
icon in the Status title bar to expand or collapse this section.
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PMT Voltages Use the PMT Voltages section during preview to select the area, 
height, width, and adjust the voltage and threshold for scatter or 
fluorescence parameters. You can also add or remove parameters.

If you are using the default tube settings and then adjust PMT 
voltages or other cytometer settings, the changes apply only to the 
current tube. If you want to reuse adjusted settings for additional 
tubes, create a new tube setting. 

See topics about creating tube settings and reference settings in the 
BD FACSVerse System Reference.
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In the PMT Voltages section, you can perform the following 
actions.

Button Description

Threshold 
Operation

1. Select And or Or to specify how multiple thresholds are combined 
logically.

Add 1. Click Add to add a new parameter.

2. Click the Name field in the blank row and select a fluorochrome.

Remove 1. Select a parameter in the PMT Voltage table.

2. Click Remove to remove the selected parameter. 

Parameter 
(Name column)

1. Click any fluorescence parameter in the table.

2. Select an available parameter and select a fluorochrome.

A (Area), 
H (Height), 
and W (Width)

A (Area) is the default parameter that measures the entire voltage pulse. H 
(Height) is the peak of the voltage pulse, and W (Width) is the amount of 
time taken for the event to pass through the laser (multiplied by a constant).

1. Select these checkboxes to specify which parameters to include in the 
acquisition. 

Voltage Adjusting the voltage changes the amount of sensitivity used by the PMT to 
view events.

 Click the up and down arrows to adjust the value in increments of 1 V.

 Ctrl+click the up and down arrows to adjust the value in increments of 
10 V.

 Drag the slider to adjust the voltage value in any increment.

Threshold An electronic threshold on a parameter to eliminate unwanted events. Only 
events with parameter values above the threshold are acquired.

1. Select the checkbox to enable threshold for the parameter.

2. Adjust the value.

– Click the up and down arrows to adjust the value in increments of 
100.

– Ctrl+click the up and down arrows to adjust the value in increments 
of 10.

– Drag the slider to adjust the voltage value in any increment.
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You can click the arrow icon in the PMT Voltages title bar to 
expand or collapse this section.

Lasers Use the Lasers section to set the area scaling and delay values for 
each configured laser. If you performed daily performance QC, the 
laser delay settings are set appropriately. The laser delay values 
should not need adjustment. The area scaling factor might require 
adjustment depending on the experiment particle size.

These settings are only temporary and do not affect tube or 
reference settings in the library. Note that changes to the delay or 
area scaling affect all tubes in the experiment. These settings are 
only saved with the experiment.

In the Lasers section, you can perform the following actions.

Button Description

Window 
Extension

This is time added to the pulse duration above the threshold to give the total 
time during which a pulse is sampled. The window extension can be set from 
0–25 µs.

The default is 3 µs (normal mode) and 5 µs (high-sensitivity mode).

FSC Area 
Scaling

Adjusts area measurements to be the same magnitude as height 
measurements for signals from the FSC detector.



BD FACSVerse System User’s Guide94

You can click the arrow icon in the Lasers title bar to expand or 
collapse this section.

About worksheets 
and reports

Worksheets are used to develop experiments and assays to visualize 
data. You can display plots, statistics, populations, and expressions 
to help visualize and calculate tube data.

Reports are used to display results and associated information and 
can include all the details you want to analyze and present in a 
final lab report. 

You can create multiple worksheets and reports. Each worksheet 
or report can include multiple pages. 

More information • Experiment overview (page 78)

• Creating tubes (page 96)

• Creating plots in a worksheet (page 98)

Name (Read-only) Indicates the name of the laser in the current configuration.

Delay Adjusts the amount of time between processing signals from different laser 
intercepts to align the signals from multiple lasers (±162.5 µs).

The delay in normal mode is typically 35 µs, and high-sensitivity mode is 
typically 70 µs.

Area Scaling Adjusts area measurements relative to height measurements for signals from 
the corresponding laser.

For optimal data, the magnitude of area and height measurements should 
match.

Button Description
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Building experiments
Introduction This topic provides the basic workflow for building an experiment.

Typical workflow Perform the following typical workflow stages for building an 
experiment. Note that this basic workflow uses default tubes and 
does not require the modification of tube properties or create tube 
settings.

More information • Creating and opening experiments (page 82)

Stage Description 

1 Add tubes (if needed) with default tube settings, or apply 
existing tube settings.

See Creating tubes (page 96).

2 Create and modify worksheet, reports, plots, and create gates 
and statistics views. 

See Creating plots in a worksheet (page 98), Previewing data 
in plots (page 100), and Drawing gates in plots (page 104).

3 Adjust cytometer settings as needed.

See Using the Experiment tab (page 85) for more information 
about the panels in the Experiment tab that you use to adjust 
cytometer settings.

4 (Optional) Create tube settings and reference settings as 
needed.

See topics about tube settings and reference settings in the 
BD FACSVerse System Reference.

5 (Optional) Modify the tube properties for each tube (if you do 
not want to use the default tube properties).

See topics about modifying tube properties in the 
BD FACSVerse System Reference.
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Creating tubes
Introduction This topic describes how to create tubes in the Data Sources panel 

by adding or duplicating tubes. This topic also describes how to 
delete tubes from an experiment. 

Adding tubes to an 
experiment

When you create a new experiment, one default tube is displayed 
in the Data Sources panel. 

To add a tube to an experiment:

1. In the Data Sources panel, click New Tube. 

A new default tube is displayed. The Lyse Wash (LW) or Lyse 
No Wash (LNW) tube settings are applied to all default tubes.

Duplicating tubes 
with or without 
data

To duplicate tubes with acquired data:

1. Before you can duplicate with data, acquire the tube.

See Acquiring data in an experiment (page 107).

2. In the tube list, right-click the tube you want to duplicate.

3. Select one of the following:

• Duplicate with data. A duplicate tube is added to the list 
with the same tube name and includes all data that is 
associated with the source tube.

• Duplicate without data. A duplicate tube is displayed with 
a new name and includes all tube properties and settings 
except the acquired data.

Adding tubes from 
entries in a worklist

To add tubes from entries in a worklist:

1. In the Data Sources panel, click Add from Worklist.

The Add Tubes From Worklist dialog opens. 
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2. Select one of the following:

• Under Entries, click a worklist entry, then click Add 
Selected Entry Tubes. 

• Under Entries, click a worklist entry. Under Tubes, click 
individual tubes that are displayed in the entry, then click 
Add Selected Tubes.

The tubes are added to the Data Sources panel.

Adding tubes using 
the Next button

To add new tubes using the Next button:

1. In the Data Sources panel, click Next to move the run pointer 
to the next tube. 

If you click the last tube in the list, and then click Next, a new 
duplicate tube without data is created and the run pointer 
moves to the tube.

Clearing data in a 
tube

To clear existing data from a tube:

1. In the Data Sources panel, right-click a tube and select Clear 
Tube.

All associated tube data is deleted and associated plots or 
statistics are cleared.

Deleting tubes 
from an experiment

To delete a tube from an experiment:

1. In the Data Sources panel, click a tube in the list.

2. Click Delete Tube.

Next step After you add tubes to the experiment, create plots on a worksheet 
to visualize tube data.



BD FACSVerse System User’s Guide98

More information • Creating plots in a worksheet (page 98)

• See topics about modifying tube properties in the 
BD FACSVerse System Reference.

• See topics about tube specific keywords in the BD FACSVerse 
System Reference.

Creating plots in a worksheet 
Introduction This topic describes how to create plots in an experiment 

worksheet.

Before you begin • Be sure that you have created tubes before you create plots 
associated to the tubes. 

• (Optional) You can also set tube properties before you begin, 
or at any time before you acquire the tube.

Creating a plot When you create a new experiment, one default tube is displayed 
in the Data Sources panel and one default plot is displayed in the 
worksheet. 

When you create additional plots, the plots display the default plot 
title and parameter names. You can modify the plot title and select 
different parameters for each axis after you create the plot.

To create a plot:

1. Open an experiment.

2. (Optional) Click Toggle Grid on the Worksheet toolbar to 
enable the grid. 

A grid on the worksheet provides guidelines for plot size and 
placement. 
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3. Click a plot tool on the Plot toolbar.

4. Click in the worksheet to create the plot.

5. Continue to add plots for your scatter and fluorescence 
parameters as needed. 

The primary data source determines which tube is associated 
to a plot or plots in the worksheet. If the run pointer is selected 
as the primary data source, all plots display data from the tube 
that is indicated by the run pointer.

Dot plot   Histogram plot Contour plot   Density plot
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Modifying plot 
parameters

To modify plot parameters:

1. Select a plot in a worksheet.

2. Right-click the x-axis parameter label, then select a parameter 
from the list.

3. Right-click the y-axis parameter label, then select a parameter 
from the list.

Next step • If you are working with un-acquired tubes, plots remain empty 
until you preview or acquire the tube to populate the plots 
with data. Continue by previewing or acquiring data.

• If a tube contains acquired data, new plots automatically 
display data. Continue by drawing gates in the plots.

More information • Previewing data in plots (page 100)

• Drawing gates in plots (page 104)

• See topics about plots in the BD FACSVerse System Reference 
for more information about plot types and tools, and creating 
and modifying plots.

• See topics about modifying tube properties in the 
BD FACSVerse System Reference.

Previewing data in plots 
Introduction This topic describes how to preview data in plots and how to 

change the data display behavior for plots.

Before you begin Create plots in the worksheet before you preview tube data.
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About previewing 
data

Previewing data is the process of starting the sample flow and 
displaying event data. Previewing does not record data. While 
previewing, you can adjust the PMT voltages and modify the tube 
properties.

This example describes previewing data from a single (manually 
loaded) tube using the run pointer as the primary data source. See 
topics about changing the primary data source for a plot in the 
BD FACSVerse System Reference.

Procedure To preview data in a specific tube:

1. Load a tube on the manual tube port. 

2. In the Data Sources panel, set the run pointer to the tube you 
want to preview (for example, Tube_002).

3. Click Preview. 

During preview, the run pointer remains blue and displays an 
activity indicator. 
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Data is displayed in the plots.

Next step Once data is displayed in plots, you can adjust the cytometer 
settings and draw gates to identify populations of interest.

More information • Previewing data in plots (page 100)

• Drawing gates in plots (page 104)



Chapter 6: Experiment acquisition and analysis 103

Adjusting the cytometer settings for a tube
Introduction This topic describes how to adjust the cytometer settings for a tube 

to optimize the sample brightness and place the events on scale. 

Procedure Perform the following adjustments as needed before or after you 
create gates in a plot. 

To adjust the cytometer settings:

1. Adjust the PMT voltages as needed to put all populations on 
scale.

a. In a plot, click the PMTV button in the lower-left corner of 
the plot to enable the data sliders.

b. Drag the slider control for each axis parameter in the plot. 

The PMTV value is displayed on the slider control. 

c. Click the PMTV button again to disable the slider control.

See About the Cytometer Settings panel (page 89) for details 
about adjusting PMT voltage using the PMT Voltages section 
of the Cytometer Settings panel.

2. Select a threshold operation as needed. 

3. Select a checkbox to enable a threshold, then adjust the 
threshold value as needed.
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4. Select area, height, and width parameters as needed.

See About the Cytometer Settings panel (page 89) for details 
about selecting parameters and adjusting values using the 
Lasers section of the Cytometer Settings panel.

5. Click Stop to stop previewing.

More information • Acquiring data in an experiment (page 107)

• Drawing gates in plots (page 104)

• See topics about changing the primary data source for a plot in 
the BD FACSVerse System Reference.

• See topics about populations and the population hierarchy in 
the BD FACSVerse System Reference.

Drawing gates in plots 
Introduction This topic describes four basic gate types and how to draw 

different types of gates to define populations in plots. 

Additional gate types including logical, interval, adaptive, and 
quad gates are described in the BD FACSVerse System Reference.

Before you begin Create plots for tubes and populate the plots with data before 
creating gates.
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Drawing gates The following table describes how to draw basic gates in plots.

To draw a... Then do this...

Rectangle gate 1. Click this tool on the Worksheet toolbar.

2. Click in the plot and drag diagonally to create and size the 
rectangle around specific events in the plot.

3. Release the mouse button to set the gate.

Polygon gate 1. Click this tool on the Worksheet toolbar.

2. Click on the plot to specify a starting point. A vertex is displayed.

3. Move the cursor to another position and click to add another 
vertex. Repeat this step to create a minimum of three vertices 
around specific events in the plot.

4. Click the first vertex or double-click to set the last vertex to close 
the gate.
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New gates are added to the hierarchy and are applied to all tubes 
within the experiment. The population hierarchy is updated to 
identify the new population.

Next step Experiment analysis (page 109)

Ellipse gate 1. Click this tool on the Worksheet toolbar.

2. Click in the plot and drag diagonally to create and size the ellipse 
around specific events in the plot.

3. Release the mouse button to set the gate.

Freehand gate 1. Click this tool on the Worksheet toolbar.

2. In the plot, click and hold the mouse button, then move the cursor 
to draw a freehand shape around specific events.

3. Release the mouse button to set the gate.

To draw a... Then do this...
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More information • See topics about gating tools, creating logical, interval, 
adaptive, and quad gates, and displaying the hierarchy in the 
BD FACSVerse System Reference for more information about 
gating options.

Acquiring data in an experiment 
Introduction This topic describes how to acquire data in an experiment. You can 

acquire data in an experiment as long as the experiment has at 
least one tube. 

Procedure To acquire data in an experiment:

1. Load a tube onto the manual tube port. 

2. In the Data Sources panel, set the run pointer to the tube you 
want to acquire (for example, Tube_001).

3. Click Acquire. 

During acquisition, the run pointer turns orange and displays 
an activity indicator. 

Acquisition continues until the stopping rules (defined in the 
Tube Properties dialog) are satisfied. 
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The acquisition status is displayed in the Acquisition Status 
panel.

During acquisition, you can click Stop to manually stop 
acquisition, or click Restart to clear the current acquisition.

When acquisition is complete, the tube icon displays as a filled 
tube to indicate that data has been acquired.

4. Click Next to move the run pointer to the next tube. 

If no next tube exists, a new tube (duplicate without data) is 
created and the run pointer moves to the tube.
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Next step After you acquire data, you can analyze the data immediately, or 
open the experiment later to analyze it.

More information • Experiment analysis (page 109)

• Creating and opening experiments (page 82)

• Experiment overview (page 78)

Experiment analysis

Introduction This topic describes the workflow for analyzing data acquired in 
an experiment.

About analyzing 
experiments

When you create an experiment, you can preview data and 
perform basic analysis by adding plots and drawing gates to define 
populations. 

A more detailed analysis might include additional plots or 
histograms, specific fluorochromes, different types of gates, custom 
statistics views, expressions, or custom reports.

You can perform analysis on the workstation that is connected to 
the cytometer or from a remote workstation with BD FACSuite 
software and exported FCS files.

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system
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Typical workflow Perform the following the tasks to analyze data in an experiment.

More information • Creating plots in a worksheet (page 98)

• Drawing gates in plots (page 104)

• Creating experiment analysis reports (page 111)

• See topics about formatting and printing reports in the 
BD FACSVerse System Reference.

• See topics about data visualization and analysis tools and the 
data analysis example in the BD FACSVerse System Reference.

Stage Description 

1 Open an existing experiment or import an experiment on a 
remote workstation.

See Creating and opening experiments (page 82).

2 Create and modify reports.

See Creating experiment analysis reports (page 111) and 
topics about modifying worksheets and reports in the 
BD FACSVerse System Reference.

3 (Optional) Export or print reports.

See topics about exporting experiment reports as PDFs in 
the BD FACSVerse System Reference.
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Creating experiment analysis reports 
Introduction This topic describes how to create custom experiment analysis 

reports. If you plan to create and run a user-defined assay, create 
and format a report when you create an experiment.

About analysis 
reports

In experiments, reports are used to report results and associated 
information and can include the details you want to present in a 
final lab report. You can include any of the worksheet elements 
(for example, plots, gates, and statistics) and create a format that 
includes company logos and custom text in the headers and 
footers. Reports are associated and saved with the current 
experiment. 

Reports are similar to worksheets in functionality. However, only 
reports can display an ESignature Box for electronic signature or 
approval. ESignature is enabled when you edit assay details.

In assays, the report displays the results after acquisition. BD-
defined assays include a pre-defined report. Reports update when 
you run an analysis.

Creating a new 
report

To create a report from a blank report sheet:

1. In an experiment, click the Add Report tool on the Worksheet 
toolbar.
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A new Report tab opens. 

2. Click the text in the Report tab, then type a new name (for 
example, Analysis Report).

3. Create plots, statistics views, and other analysis elements. 

The report is automatically saved with the experiment.

More information • Experiment analysis (page 109)

• See topics about exporting experiment reports in the 
BD FACSVerse System Reference.

Creating a user-defined assay from an experiment 
Introduction This topic describes how to create a user-defined assay from an 

experiment.

About saving 
experiments

Experiments are automatically saved as you make changes to them. 
Creating a user-defined assay from an experiment is useful when 
an experiment must be repeated often by you or others. The user-
defined assays provide uniform cytometer settings and format.

When you create a user-defined assay from an experiment, all 
properties, parameters, and preferences become permanent in the 
assay. You cannot edit these properties and parameters in the 
worklist. 
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If you want to edit properties, you must create an experiment from 
the assay, modify it, then save it as a user-defined assay again with 
the same name.

Procedure To create a user-defined assay from an experiment:

1. Build or open an experiment in the Experiment workspace.

See Creating and opening experiments (page 82).

2. From the menu bar, select File > Create Assay.

The Create Assay dialog opens.

3. In the Name field, type a name for the new user-defined assay.

If you intend to modify an existing user-defined assay and 
want to retain the same assay name, you can overwrite the 
original by creating an assay with the same name.

See topics about creating a new experiment from an assay in 
the BD FACSVerse System Reference.

4. (Optional) In the Description field, type a description of any 
details you want to document for the assay.

5. (Optional) Select the Share checkbox if you want this user-
defined assay to be shared with all users. 

You can also make the assay shared from within the library 
after you save it.

6. (Optional) Select a report to display in the Report to Display 
After Entry Run list. 

This sets the default report that appears after the worklist 
runs.
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7. Click OK. 

The user-defined assay is added to the library. 

More information • Building a worklist (page 131)

• See topics about working with private and shared library 
resources in the BD FACSVerse System Reference for more 
information about sharing user-defined assays.



7
Worklist acquisition and analysis

This chapter includes the following topics:

• Worklist overview (page 116)

• Using the Manage tab (page 117)

• Worklist tab overview (page 119)

• Worklist acquisition workflow (page 129)

• Building a worklist (page 131)

• Acquiring data in a worklist (page 133)

• Worklist run options (page 138)

• Reacquiring entries in a worklist (page 141)

• Worklist analysis (page 143)

• Working with assay reports (page 146)
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Worklist overview
Introduction This topic describes the Manage and Worklist tabs in the Worklist 

workspace.

A worklist is a list of tasks to be performed for sample acquisition 
and analysis. The worklist organizes multiple entries, which 
include sample IDs, tubes, tasks, status, and other information 
about the sample. 

About the Worklist 
workspace

The Worklist workspace includes the Manage tab and Worklist 
tabs which represent open worklists.

To open the Worklist workspace, click Worklists in the navigation 
bar, or click a worklist shortcut on the Home page.

Use the Manage tab to create new worklists, open existing 
worklists, and filter, search, and share worklists with other users. 
Use the BD FACSuite menus to create, rename, import, and export 
worklists.

Manage tab
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Use the Worklist tab to develop your worklist and acquire and 
analyze the data using different analysis tools.

Using the Manage tab 
Introduction This topic describes how to use the worklist Manage tab to create 

or open a worklist.

This topic describes how to use the worklist Manage tab to create, 
open, or import a worklist, and how to change the share settings, 
sort, filter, and delete worklists.

Worklist tab
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Creating a worklist To create a worklist:

1. On the navigation bar, click Worklists. 

The Manage tab opens.

2. From the menu bar, select File > New Worklist.

The new worklist opens as a new tab in the Worklist 
workspace.

Opening an 
existing worklist

To open an existing worklist:

1. In the Manage tab, double-click a worklist in the Worklist 
Information table.

More information • Worklist tab overview (page 119)

• BD FACSuite preferences (page 48)

• Building a worklist (page 131)

• See topics about setting worklist preferences in the 
BD FACSVerse System Reference for more information about 
exported file preferences.
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Worklist tab overview
Introduction This topic describes the different panels in the Worklist tab and 

how you use them to build and run worklists.

About the Worklist 
tab 

When you create a new worklist or open an existing worklist in the 
Manage tab, a new Worklist tab opens. Use the Worklist tab to 
build and run a worklist. This tab includes the following controls, 
panels, and tables:

• Worklist controls

• Layout View

• Acquisition Status

• Tasks

• Loading Options

• Cytometer

• Worklist Entries table (worklist)

• Entry Details
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About the Worklist 
Controls

The Worklist Controls bar is displayed at the top of the Worklist 
tab and includes options for different worklist acquisition, re-
acquisition, analysis, and stopping conditions. The following table 
describes the worklist controls.

Control Description

Load Click this button to load the sample carrier (tube rack or plate) with the 
optional Loader.

Unload Click this button to manually unload the current sample carrier with the 
optional Loader.

Mix Click this button to perform any mix actions on the sample carrier (based on 
default or custom sample carrier preferences).

Run All Click this button to acquire unacquired entries, tubes, or wells, or analyze 
acquired entries. Click the arrow button to select additional options. A worklist 
run begins with preview mode, then begins acquiring after the Acquisition 
Delay Timer expires. 

Re-Acquire 
Selected

Click this button to reacquire any acquired entries, tubes, or wells. Click the 
arrow button to select additional options.

Skip Tube Click this button to skip tubes, entries, or sample carriers during an acquisition 
or analysis run. Click the arrow button to select additional options.
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See Worklist run options (page 138) for more information about 
the Worklist controls.

Stop Tube Click this button to stop a tube (immediately). Click the arrow button to select 
to stop the run after a tube completes, or stop the run after an entry completes. 

Stop Timer

Resume

Before acquisition
During preview mode, the Stop Timer button controls the Acquisition Delay 
Timer.

Click this button to manually stop the timer countdown for a specific duration 
(defined by the Acquisition Delay Timer) and pause the worklist before 
acquisition begins. You can stop the timer if you need to adjust PMT voltages, 
thresholds, or modify gates and statistics markers. 

If you make changes, a dialog opens. In this dialog, select how you want to 
apply these changes to the worklist.

The next tube or entry in the worklist automatically starts when the pre-defined 
Acquisition Delay Timer time expires, or if you click Resume.

After acquisition
After acquisition, the Stop Timer button controls the Report Delay Timer. The 
report displays data from an acquired entry until the timer expires. You can 
click Stop Timer (before time expires) to continue viewing the report and adjust 
gates and statistics markers. 

Click Resume to resume acquisition and display the next entry in the report.

You can adjust the duration of the Acquisition and Report delay timers in the 
Preferences dialog. 

Control Description
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About the Layout 
View panel

The Layout View panel displays the carrier ID of the tube rack or 
plate and the tube or well layout. The order of tubes is based on 
where they are displayed in the worklist. 

Right-click a tube or well in the layout to display properties of the 
tube or well.
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About the 
Acquisition Status 
panel

Use the Acquisition Status panel to view real-time status for time, 
event counts, and aborts. You can also set flow rate, events to 
display, and SIT flush options specific to an acquisition.

The settings apply to the entire worklist, not individual tubes. For 
some BD-defined assays, the assay controls the flow rate, events to 
display, and the SIT flush settings.



BD FACSVerse System User’s Guide124

About the Tasks 
panel

The Tasks panel lists the available BD-defined and user-defined 
assays, and fluidics tasks you can add to a worklist.

You can select one or more tasks, then click Add. You can also 
select a task, then add the task multiple times by typing a number 
in the field, then clicking Add.

About the Loading 
Options panel

Use the Loading Options panel to select the carrier type and 
manual or automated loading mode. The default is 40 Tube Rack, 
Loader (automatic mode). 



Chapter 7: Worklist acquisition and analysis 125

If you do not have the Loader option installed, the default is 
Manual.

In automatic mode, you can select the Unload sample carrier at the 
end of Worklist Run checkbox if you want to automatically unload 
the sample carrier after acquisition.

Select the Lock Positions checkbox if you want to maintain the 
physical location of the target tubes or wells—even if you re-order 
or add new entries in the worklist. This can be helpful when you 
are manually preparing samples to run using the Loader. Note that 
you cannot unlock the positions once you lock them. 

About the 
Cytometer panel

Use the Cytometer panel to view system status, run cleaning 
protocols, and adjust PMT voltages.

The Status section displays the system status, including real-time 
status for the manual load port and Loader, fluidics, and lasers. 



BD FACSVerse System User’s Guide126

A checkmark indicates a ready status. This tab also reminds you 
when you need to run system cleaning protocols.

Use the PMT Voltages section to view and adjust the PMT 
voltages, area, height, width, and enable and adjust thresholds for 
scatter or fluorescence parameters. You can also add or remove 
parameters before you run a worklist.
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During preview mode, you can adjust threshold and PMT voltages 
and the system will automatically adjust spillover values for the 
current worklist only.

About the Worklist 
Entries table

The Worklist Entries table (worklist) organizes multiple entries to 
be acquired or analyzed, and displays status and other information 
about the entry.

Worklists include the following elements.

Worklist 
elements Description

Entries An entry includes a sample ID, tubes, and one task. 

You can start a new worklist with blank entries and add new tasks. You 
can also start by importing saved entry run packages into the worklist. An 
entry run package includes all information needed to replicate an entry in 
a different worklist. This includes acquired data.

You can acquire individual entries, tubes, or an entire worklist, then 
perform individual sample analysis or batch analysis (entire worklist).

Each entry has an ID. Each tube within an entry is a child of the entry. For 
example, if a entry number is 1, then the tube IDs are 1.1, 1.2, and 1.3. 

Sample ID Each entry requires a sample ID. You can specify a sample ID by typing in 
the Sample ID column for an entry, or by clicking in the column and 
scanning the barcode that contains the information.
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Task A task is an action that is performed when you run a worklist. Tasks 
identify the assay (BD-defined or user-defined) or a fluidics action. 

Assays are a collection of tubes. There are two types of assays that you 
can run in a worklist: 

 BD-defined assays

 User-defined assays

Fluidics tasks include:

 Daily clean

 SIT flush

 Shutdown

When you add a task in the Task column, all tubes associated with the 
task are added to the entry.

Status The current entry status is displayed in the Status column. 

 Ready. Indicates that the entry has a sample ID and a task.

 Not Ready. Indicates that the entry does not have a sample ID or task.

 Ready for Acquisition. Indicates that the tube is ready to be acquired 
and has all required information.

 Complete. Indicates that the entry or tube has been acquired.

 Ready For Approval. Indicates that the entry or tube has been 
acquired and requires approval. This is displayed when Automatically 
Approve is not enabled for the assay (default).

 Approved. Indicates that the entry or tube has been approved. This is 
displayed when Automatically Approve is enabled for the assay.

 Needs Review. Indicates that changes were made to an audited entry. 
This is displayed when an audit trail is enabled.

Location The Location column identifies the tube or well location used for this 
entry.

Sample 
Carrier

The Sample Carrier column identifies the tube rack or plate for this entry.

You can select different sample carrier types using the Loading Options 
panel. You can select a specific carrier using the Layout View panel.

Worklist 
elements Description
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More information • BD FACS Universal Loader (page 149)

• See topics about managing worklists in the BD FACSVerse 
System Reference for more information about performing 
worklist management tasks.

• See topics about defining tube rack or plate layouts and using 
the Tray Layout with worklists in the BD FACSVerse System 
Reference for more information about the Tray Layout panel.

• See topics about assigning keywords in the BD FACSVerse 
System Reference for more information about assigning 
keywords to samples or tubes in a worklist.

Worklist acquisition workflow 

Introduction This topic describes the typical workflow stages you need to 
complete to build a worklist and acquire data. 

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system
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Workflow stages Perform the following typical workflow stages for acquiring entries 
and tubes in a worklist.

More information • Worklist overview (page 116)

Stage Description

1 Open an existing worklist, or create a new worklist and create 
new entries.

See Building a worklist (page 131).

2 Run the worklist.

See Acquiring data in a worklist (page 133).

3 (Optional) Modify worksheet elements or instrument settings 
(as permitted). You can only modify elements based on user 
privileges and assay type.

See topics about plots and gates in the BD FACSVerse System 
Reference.

4 (Optional) Approve the changes and/or results.

See topics about approving entries in a worklist in the 
BD FACSVerse System Reference.

5 Save, print, or export results, FCS files, or entry run packages. 

See Working with assay reports (page 146) and topics about 
exporting entries in the BD FACSVerse System Reference.
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Building a worklist 
Introduction This topic describes how to build a worklist using default 

preferences. It includes information about creating or opening a 
worklist and adding entries. Once you build the worklist, you can 
save it, export it, or begin acquiring data. 

See topics about worklist preferences, assigning keywords to 
entries or tubes, and enabling audit trails in the BD FACSVerse 
System Reference.

Building a worklist You can set worklist preferences for acquisition delay and report 
delay timers, manual tube loading, exporting, and printing.

To build a worklist:

1. Create a new worklist or open an existing worklist. 

2. In the first blank row in the worklist, click in the Sample ID 
column, type a sample ID for an entry or scan a barcode, and 
then press Enter.

A new entry is displayed in the worklist.

3. Click in the Task column and select an assay or fluidics task. 

All tubes associated with the task are added to the entry.
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If you want to add multiple tasks to a worklist (at the same 
time), you can add tasks using the Tasks panel. See About the 
Tasks panel (page 124).

When you add a sample ID and a task, the Status column 
displays Ready. Each associated tube displays Ready to 
Acquire. 

4. (Optional) Once you add an entry, assign keywords to an entry 
or tube, or enable an audit trail for the entry.

See topics about assigning keywords to entries or tubes, and 
working with audit trails in the BD FACSVerse System 
Reference.

5. When you are finished adding entries you can do any of the 
following: 

• Modify the default loading options. 

• Modify worksheet or report elements, or instrument 
settings (as permitted by the assay type or your user 
privileges).

• Begin acquisition.

• Close and save the worklist.

Saving a worklist Worklists are automatically saved as you add entries or make 
changes. You can also manually save the worklist at any time. All 
worklist entries and acquired data are saved only with the worklist 
(not as separate entities). 

To save a worklist when you close it:

1. Click the X on the worklist tab to close the worklist.

The Save Worklist dialog opens. 

2. In the Worklist Name field, type a name and click the Save 
button. 
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To save the worklist at any time:

1. From the menu bar, select File > Save.

Next step Acquiring data in a worklist (page 133)

More information • See topics about managing worklists in the BD FACSVerse 
System Reference for more information about sorting, 
exporting, and deleting worklists.

• See topics about defining tube rack or plate layouts and using 
the Layout View with worklists in the BD FACSVerse System 
Reference for more information about the Layout View panel.

• See topics about exporting entries in the worklist in the 
BD FACSVerse System Reference for more information about 
entry run packages.

Acquiring data in a worklist 
Introduction This topic describes the worklist controls and how to load tubes or 

plates and start acquisition for assays in a worklist. 

Acquisition is performed only on entries that do not have an 
associated FCS file. If you want to reacquire an entry, tubes, or a 
worklist, see Reacquiring entries in a worklist (page 141).

Before you begin • Run performance QC and assay and tube settings setup.

• Build a worklist.

Loading or 
unloading tubes or 
plates

If you have the Loader option, you load prepared sample carriers 
onto the Loader, then the sample carriers are automatically loaded 
into the cytometer. If you do not have the Loader option, you need 
to load each tube manually.
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1. Complete one of the actions in the following table.

Running entries in 
the worklist

To run entries in a worklist:

1. Make sure that the entry is ready to be acquired. The Status 
column should display Ready (entry) and Ready to Acquire 
(tubes).

To... Then do this...

Manually load a single tube 1. Click Run All.

2. Follow the system prompts for loading and unloading 
tubes.

3. When the LED ring light turns green, place a tube onto 
the manual tube port and press the top of the tube onto 
the gasket until you feel a click.

The LED ring light turns off. 

4. Repeat for each tube as needed.

Manually unload a single tube Carefully pull the tube down from manual tube port.

Automatically load a tube rack 
or plate

1. Make sure the sample carrier is loaded onto the Loader 
tray.

2. Click Load or Run All on the Worklist Controls bar.

Unload a tube rack or plate If Unload sample carrier at the end of the run is selected in 
the Loading Options panel, the sample carrier 
automatically unloads after the acquisition completes. 

If the checkbox is not selected, the sample carrier remains 
in position until you click Unload in the Worklist Controls 
bar.
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2. In the Worklist Controls bar, click Run All.

3. Follow the instructions on the dialog that opens. 

The worklist run starts by previewing the first unacquired 
tube. 

4. (Optional) Pause the worklist in preview mode. 

a. Click Stop Timer to manually stop the acquisition delay 
timer countdown and pause the worklist for a specific 
duration before acquisition begins. 

Stop the timer if you need to adjust PMT voltages, 
thresholds, or modify gates and statistics markers. If you 
make changes, the Preview dialog opens.

b. Select how you want to apply these changes to the worklist, 
then click OK.
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c. Click Resume. Acquisition of the tube automatically starts.

As acquisition progresses, the Acquisition Status panel displays 
the time, events, and an acquisition progress bar. The run 
pointer moves to the next entry as each entry completes, until 
each entry is completely acquired.

5. (Optional) Review the results during assay acquisition.

During acquisition, the results are displayed on the assay 
worksheet in the Entry Detail panel. Data is displayed in the 
report after the entry is acquired.

6. (Optional) Modify gates or statistics on the report once the 
report is populated with data.

After acquisition, the Stop Timer button controls the report 
delay timer. The report displays data from an acquired entry 
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until the timer expires. You can click Stop Timer (before time 
expires) to continue viewing the report and adjust gates and 
statistics markers. Click Resume to resume acquisition and 
display the next entry or tube in the report.

See topics about worklist preferences in the BD FACSVerse 
System Reference for information about changing the timer 
settings.

7. (Optional) After acquisition, select a row in the worklist to 
manually display the worksheets and reports of tubes and 
entries.

8. (Optional) View the tube properties for any tube in the entry 
by selecting a tube in the Entry Detail toolbar.

9. (Optional) View acquired data for specific tubes by selecting a 
current tube for this entry in the Entry Detail toolbar.

You can also click the arrow buttons on the right side of the 
toolbar to view results for the previous entry or the next entry.

Next steps You can continue by approving acquired entries, re-acquiring 
specific entries in a worklist, exporting entry run packages, or 
performing analysis on the acquired entries.
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More information • Worklist analysis (page 143)

• Worklist run options (page 138)

• Loading or unloading tubes or plates (page 133)

• Reacquiring entries in a worklist (page 141)

• Running daily performance QC (page 71)

• Worklist tab overview (page 119)

• See topics about modifying tube properties in the 
BD FACSVerse System Reference.

• See topics about approving entries in a worklist in the 
BD FACSVerse System Reference.

Worklist run options
Introduction This topic describes worklist run options. 

About worklist run 
order

Acquisition can be performed in different run order depending on 
the acquisition status of the tubes and where you want to start in a 
worklist. Once you start a worklist run, you cannot re-order tubes 
or entries during acquisition. You can add entries to the end of the 
worklist as it is running. However, the entry is assigned to a new 
sample carrier.

If you are using the Loader option, you can use the Layout View 
panel to view wells and tubes as they are ordered in the worklist. If 
you re-order entries or tubes in the worklist, the tray layout 
updates to match the worklist. If you prefer, you can lock the tray 
layout for a sample carrier, so that worklist changes do not affect 
the current layout. Any new entries are assigned to a different 
sample carrier. If you lock the tray, you cannot unlock it.
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Running all entries To run all entries:

1. Click Run All in the Worklist Control bar.

If your worklist includes acquired and unacquired entries, a 
dialog opens. 

• Click Start Acquisition Run to acquire any unacquired 
tubes or entries. 

• Click Start Batch Analysis Run to start analyzing acquired 
tubes or entries.

If your worklist includes acquired entries or tubes (FCS files 
exist for the entry or tube), you can reacquire. See Reacquiring 
entries in a worklist (page 141).

If you do not want to run the entire worklist from start to finish, 
you can perform one of the actions in the following sections.
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Running one or 
multiple entries

To run one or multiple entries in a worklist:

1. Complete one of the actions in the following table.

Skipping tubes, 
entries, and carriers

To skip tubes, entries, and sample carriers:

1. Complete one of the actions in the following table.

To... Then do this...

Run from a specific 
entry or tube and all 
subsequent tubes

1. Click a specific entry or tube in the worklist to set the run pointer.

2. Click the arrow next to the Run All button and select Run from 
pointer.

The worklist starts with the specified tube, then runs all 
subsequent tubes in the worklist.

Run a specific entry 
or tube in the 
worklist. 

1. Ctrl+click entries or tubes anywhere in the worklist. The tubes do 
not need to be adjacent in the worklist.

2. Click the arrow next to the Run All button and select Run selected.

The worklist starts with the specified tube and continues with the 
next selected entry or tube in the worklist. 

To... Then do this...

Skip a tube in a 
worklist

1. Click a specific tube in the worklist.

2. Click Skip Tube.

Skip an entry 1. Click a specific entry in the worklist.

2. Click the arrow next to the Skip Tube button and click Skip Entry.

Skip a carrier type This applies only to systems using the optional Loader hardware.

1. In the Sample Carrier ID column, click a specific carrier for a tube.

2. Click the arrow next to the Skip Tube button and click Skip 
Sample Carrier.
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Stopping a worklist 
run

To stop the worklist run:

1. Complete one of the actions in the following table.

More information • Worklist overview (page 116)

• Acquiring data in a worklist (page 133)

• Reacquiring entries in a worklist (page 141)

Reacquiring entries in a worklist 
Introduction This topic describes when you can reacquire entries, tubes, or the 

entire worklist and how to reacquire them. 

You can only reacquire if FCS files exist for the entry or worklist.

To... Then do this...

Stop the current tube 
immediately

1. Click a specific tube in the worklist.

2. Click Stop Tube.

Stop the worklist 
after the current 
tube completes

1. Click a specific tube in the worklist.

2. Click the arrow next to the Stop Tube button and click Stop After 
Tube Completes.

Stop the worklist 
after the current 
entry completes

1. Click a specific tube in the worklist.

2. Click the arrow next to the Stop Tube button and click Stop After 
Entry Completes.
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How you know 
when FCS files exist

After an entry or tube is acquired, a message is displayed in the 
Status column of the worklist.

• If the Status column displays Complete, or if the tube icon is 
displayed as a filled tube, then an FCS file exists and you can 
reacquire if needed.

• If the Status column displays Ready To Acquire, you have not 
acquired the entry or tube and no FCS file exists. 

Reacquiring in a 
worklist

To reacquire in a worklist:

1. Complete one of the actions in the following table.

To... Then do this...

Reacquire an 
entire worklist

1. Select the first tube in the worklist. 

2. Click Re-Acquire All. 

This reacquires all tubes in the worklist that have an FCS file.

If your worklist includes acquired and unacquired entries, a dialog 
opens. Use this dialog to select how to run acquired or unacquired 
entries.

Reacquire from 
a specific 
starting point

1. Set the run pointer at a specific tube.

2. Click the arrow next to the Re-Acquire All button, then click Re-
Acquire from Pointer. 

This reacquires all subsequent tubes in the worklist that have an FCS 
file.
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More information • Worklist analysis (page 143)

• Worklist run options (page 138)

Worklist analysis

Introduction This topic describes what you can analyze in a worklist and how 
worklist analysis works. It also provides a worklist analysis 
workflow and instructions for analyzing individual entries and 
entire worklists.

About worklist 
analysis

Analyzing worklists is an automated process that results in an 
automatically generated report and/or automatically exported 
statistics files.

You can analyze any individual entry or tube that has been 
acquired, or use batch analysis to analyze all acquired entries or 
tubes in a worklist. Batch analysis allows you to increment files, 
pause between data sets, and print automatically.

Reacquire 
specific entries 
or tubes

1. Ctrl+click to select specific tubes that have an FCS file.

The selected entries or tubes do not have to be adjacent.

2. Click the arrow next to the Re-Acquire All button, then click Re-
Acquire Selected. 

Restart a 
partially 
acquired tube

1. Select the tube that was stopped.

2. Click the arrow next to the Re-Acquire All button, then click Re-
Acquire Selected. 

To... Then do this...

Start up 
the system

Perform
Setup & QC

Acquire data Analyze data
Shut down
the system
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Acquisition and batch analysis cannot run simultaneously for the 
same worklist. However, a worklist acquisition can be running 
while a different worklist batch analysis is running.

You can start an acquisition run and simultaneously analyze the 
results of a selected tube or entry in the same worklist. 

See topics in the following sections about analyzing entries and 
tubes in a worklist, and working with assay reports.

Typical analysis 
workflow

The following table describes the typical worklist analysis 
workflow stages.

Before you begin You need to have acquired data from at least one entry or tube. 
Batch analysis is performed only on entries or tubes that have an 
associated FCS file. A worklist batch analysis run skips tubes that 
do not have an FCS file. 

Stage Description

1 Create a new worklist and import entry run packages, or 
open an existing worklist.

See Using the Manage tab (page 117) and Building a worklist 
(page 131).

2 Modify worksheet or report elements, or instrument settings 
(as permitted). 

See Worklist tab overview (page 119).

3 Run the worklist.

See Worklist run options (page 138).

4 Approve the results.

See topics about approving entries in a worklist in the 
BD FACSVerse System Reference.

5 Print or export results, FCS files, or entry run packages.

See topics about exporting entries and worklists in the 
BD FACSVerse System Reference.
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Analyzing selected 
entries or tubes in 
a worklist

To run analysis on selected entries or tubes in the worklist:

1. Click an entry or tube in the worklist that has been acquired 
and includes an FCS file. 

This is indicated by a Complete status in the Status column for 
the entry or tube.

2. Click Run Selected on the Worklist control bar. 

Analysis begins.

3. The analysis preview opens in the assay worksheet.
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Performing analysis 
on an entire 
worklist

To run analysis on an entire worklist:

1. Click Run All on the Worklist control bar. 

Batch analysis begins and analyzes entries and tubes with 
acquired data.

More information • Acquiring data in a worklist (page 133)

• Working with assay reports (page 146)

Working with assay reports
Introduction This topic describes how to view assay reports and how to modify 

report elements and save the assay as a new user-defined assay. 

About assay 
reports

Reports must be created in an experiment. When you create a user-
defined assay from an experiment, the report is included in the new 
user-defined assay. If your user-defined assay includes a report, the 
plots and statistics automatically display data when you acquire or 
analyze a worklist. 

If you are using a BD-defined assay, reports are included in the 
assay. The plots and statistics automatically populate with data 
when you acquire or analyze a worklist.

If you want to modify an assay report, you must create a new 
experiment from the assay, modify the report, then create a new 
user-defined assay from the modified experiment. When you create 
an experiment from a BD-defined assay, the reports and data are 
removed. When you create an experiment from a user-defined 
assay, the report and data is included.

See topics about creating a new experiment from an assay in the 
BD FACSVerse System Reference for more information about 
modifying assays.

Reports are automatically saved with the worklist.
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Viewing reports in 
the worklist

After you run a worklist, the report is displayed in the Entry 
Details panel. The plots and statistics are populated with acquired 
data.

Viewing saved 
reports

To review a saved assay report:

1. In the navigation bar, click Worklists.

2. In the Manage tab, double-click a worklist in the Worklist 
Information table.

The saved worklist opens and the saved report is displayed in 
the Entry Detail panel.
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3. If an E-signature box is displayed at the bottom of the report, 
the report might require approval or electronic signature. 
Perform your typical procedure for approval.

Modifying user-
defined assay 
report elements

See Creating experiment analysis reports (page 111) and topics 
about formatting and printing reports in the BD FACSVerse 
System Reference.

More information • Worklist analysis (page 143)

• See topics about editing assay report preferences in the 
BD FACSVerse System Reference for more information about 
customizing assay reports.

• See topics about approving reports and E-signature in the 
BD FACSVerse System Reference for more information about 
approving and E-signing reports.
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BD FACS Universal Loader

This chapter includes the following topics:

• BD FACS Universal Loader overview (page 150)

• Sample carrier specifications (page 153)

• Placing carriers into the Loader (page 154)

• Defining custom sample carrier layouts (page 156)

• About mixing settings (page 160)

• Selecting custom mixing settings (page 161)

• Cleaning the Loader (page 162)
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BD FACS Universal Loader overview
Introduction This topic gives an overview of the components of the BD FACS 

Universal Loader (the Loader). 

About the Loader The Loader is an optional automated loading system that mixes 
samples and delivers tube racks and plates to the BD FACSVerse 
cytometer for acquisition. The Loader can be included as an option 
on a new system or it can be ordered and installed at a later time 
by a BD field service engineer.

External 
components

The following figure shows the location of the Loader’s external 
components.

Eject 
button

Cover

LoaderStatus indicator
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Status indicator The status indicator uses illumination and color to show the status 
of the Loader.

Eject button The Eject button should be used if there is a problem during 
operation. Pressing this button stops acquisition and moves the 
carrier out to the loading position. 

Internal 
components

The following figure shows the location of the internal 
components.

Condition Status

Off Ready to operate

Note: If main power to the system is off, this 
indicator is off.

Blue Cover is locked and system is running

Blinking blue Loading or unloading

Red Error condition

Carrier nest

Carrier 
release lever

A1 location Gripper mechanism
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Overhead imaging 
system

The Loader has an internal overhead imaging system that can 
detect:

• The presence and location of tubes in racks

• The correct type and orientation of carriers

• Lids on plates

Only compatible carriers can be used for this system to work.

Recommendations 
for using the 
Loader 

Follow these recommendations to ensure that the Loader operates 
correctly.

• Do not use any tubes, racks, or plates that are not listed as 
compatible carriers. See Sample carrier specifications 
(page 153).

• Do not use black plates.

• Keep the top surface of tube racks clean so that the camera 
imaging system works properly.

• Inspect the flange, upper lip, and barcode label on all tube 
racks for signs of wear and replace it if excess wear is found. 
See Placing carriers into the Loader (page 154).

• Inspect the numbers on the top surface of tube racks to make 
sure they are legible and not faded.

• Keep all barcode labels clean and dry.

• Do not use CONTRAD® detergents for any cleaning 
procedures when using the Loader.

• Do not autoclave tube racks.

More information • Worklist overview (page 116)
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Sample carrier specifications
Introduction This topic describes the types of sample carriers (tube racks and 

plates) that are compatible with the Loader.

Carrier type 
compatibility

The following tables list the carrier types that are compatible with 
the Loader. The tube racks are available only from BD. 

For information on part numbers and additional details on 
compatible carriers, see the BD FACSVerse section of the BD 
Biosciences website.

The minimum and maximum volumes for tubes and wells are 
shown. Volumes below the minimum may need additional mixing 
to resuspend the sample. Using volumes above the maximum could 
result in cross-contamination and spillage during mixing.

Carrier type for tubesa

a. For polystyrene, polypropylene, and BD Trucount tubes.

Recommended 
minimum 

volume (µL)
Maximum 

volume (µL)

30-tube rack (12 x 75 mm) 100 2,000

40-tube rack (12 x 75 mm) 100 2,000

Carrier type for plates
Bottom 
geometry Materiala

Recommended 
minimum 

volume (µL)
Maximum 

volume (µL)

96 standard height Round PS 55 200

96 standard height Flat PS 55 200

96 standard height Round PP 55 200

96 standard height Conical PP 55 200

384 standard height Flat PS 40 75

96 half deep Conical PP 55 500
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Barcode reading The system can read barcodes on plates, tube racks, and individual 
tubes in 30-tube racks. To confirm the identification and correct 
location of tubes in racks, the barcodes must first be entered into a 
worklist with the handheld barcode reader or entered manually. 
Then the readers in the Loader can confirm that the correct 
barcode has been recognized.

See topics about barcode label specifications in the BD FACSVerse 
System Reference for more information about barcode scanning 
and barcode labels.

Placing carriers into the Loader
Introduction This topic describes how to place sample carriers into the Loader.

Before you begin Confirm that the carrier type you are using is compatible with the 
Loader. See Carrier type compatibility (page 153).

Procedure To place a carrier into the Loader:

1. Open the cover.

2. Push the carrier release lever toward the back and hold it open. 

96 deep Conical PP 55 1,000

96 matrix tube rack N/A N/A 55 700

96 filter bottom Filter PP 150 200

a. PS = polystyrene, PP = polypropylene

Carrier type for plates
Bottom 
geometry Materiala

Recommended 
minimum 

volume (µL)
Maximum 

volume (µL)
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3. Install the carrier into the carrier nest with the carrier centered 
on the nest, then release the lever as you continue to hold the 
carrier centered.

This is especially important with heavier carriers such as tube 
racks, deep-well plates, and matrix tube racks. Make sure that 
the flange along the perimeter of the carrier is held securely in 
the gripper mechanisms, as shown in the following figure.

The following figure shows a tube rack loaded onto the nest.

More information • Sample carrier specifications (page 153)

Gripper 
mechanism

Flange
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Defining custom sample carrier layouts 
Introduction This topic describes how to define custom sample carrier layouts 

for a worklist. This applies only to systems that include the Loader 
option. 

Custom layouts are saved with a worklist. You need to perform 
this procedure only if you want to define a layout different from 
the default. The default is set as a preference in the Preferences 
dialog.

Defining a plate 
layout

To define a plate layout:

1. Create a new worklist or open an existing worklist.

2. Navigate to the Loading Options panel.

3. Select a carrier type. For example, 96 Well Plate Standard flat 
bottom.

4. In the Layout View panel, right-click a tube or well and select 
Display Properties.

The Plate Properties dialog opens.

5. (Optional) In the General tab, click to select the location of the 
plate notches to set the plate orientation at the Loader.
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This setting is only required if you are using a plate that is not 
on the list of BD-qualified plates. 

6. (Optional) To read the plate barcode label during loading, 
select the Read Plate Bar Code Label checkbox.

7. Under Plate Layout, click the arrow and select a linear 
horizontal, linear vertical, serpentine horizontal, or serpentine 
vertical layout.

8. (Optional) Make the following selections:

• If you do not want to include the wells on the horizontal or 
vertical edges, select the Don’t use edge positions checkbox. 

• Select the number of empty positions in the layout between 
each well.

• Select the number of empty positions in the layout between 
worklist entries.

9. (Optional) If you want to apply these settings to multiple 
plates:

a. Click Apply settings to multiple carriers.
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b. Select the Apply to all carriers in list checkbox or select 
specific carriers in the list.

10. Click Apply Settings.

Defining a tube 
rack layout

To define a tube rack layout:

1. In the Loading Options panel, in the Carrier Type field, click 
and select a tube rack type. For example, 40 Tube Rack.

2. In the Tray Layout panel, right-click a tube and select Display 
Properties.

The Rack Properties dialog opens.

3. (Optional) To read the rack barcode label during loading, 
select the Read Rack Bar Code Label checkbox.
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4. Under Rack Layout, click the arrow and select a linear 
horizontal, linear vertical, serpentine horizontal, or serpentine 
vertical layout.

5. (Optional) Make the following selections:

• If you do not want to include the tubes on the horizontal or 
vertical edges, select the Don’t use edge positions checkbox. 

• Select the number of empty positions in the layout between 
each tube.

• Select the number of empty positions in the layout between 
worklist entries.

6. (Optional) If you want to apply these settings to multiple 
racks:

a. Click Apply settings to multiple carriers.

b. Select the Apply to all carriers in list checkbox or select 
specific carriers in the list.

7. Click Apply Settings.
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About mixing settings
Introduction This topic describes the mixing settings for systems equipped with 

the Loader. 

Types of mixing 
settings

You can set two types of mixing settings:

• Initial mixing. The first mix that happens when the carrier is 
run. The initial mixing setting is designed to resuspend the 
samples, even if they have been sitting overnight. Because of 
this, the initial mix is more aggressive than the interim mix.

• Interim mixing. Any subsequent mixes that are defined by time 
or interval.

Mix settings 
specifications

For information on mixing specifications and ranges for 
compatible carriers, see the BD FACSVerse section of the 
BD Biosciences website.

More information • Selecting custom mixing settings (page 161)

• Sample carrier specifications (page 153)
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Selecting custom mixing settings
Introduction This topic describes how to select custom mixing settings. 

Procedure Default mixing preferences are set in the Preferences dialog. You 
can specify custom mixing settings using the Rack Properties or 
Plate Properties dialog in the Worklist workspace.

To select custom mixing settings:

1. In the Rack Properties or Plate Properties dialog, click the 
Mixing tab.

2. Under Initial Mixing, select the Initial Mixing checkbox to 
enable initial mixing.

3. Set a custom mixing duration in the Duration (sec) field.

4. Set a custom mixing intensity in the Intensity (rpm) field.
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5. Under Interim Mixing, select the Interim Mixing checkbox to 
enable interim mixing.

6. Select a time or interval-based interim mixing type.

• If you select Time, then set a time interval between mixes in 
the Interval (sec) field.

• If you select Interval, then set a tube or well interval in the 
Interval (tubes or wells) field.

7. Set a custom interim mixing duration in the Duration (sec) 
field.

8. Set a custom interim mixing intensity in the Intensity (rpm) 
field.

9. (Optional) If you want to apply these settings to multiple 
racks:

a. Click Apply settings to multiple carriers.

b. Select the Apply to all carriers in list checkbox or select 
specific carriers in the list.

10. Click Apply Settings.

More information • About mixing settings (page 160)

Cleaning the Loader
Introduction This topic describes how to clean the Loader. It is a good practice 

to perform this cleaning daily.

Required materials • 10% bleach solution in a squirt-type bottle

• DI water

• Disposable towels or wipes.
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Caution

Procedure To clean the Loader:

1. Apply the 10% bleach solution to a disposable towel, then 
wipe down the following areas:

• Top surface of the carrier nest

• Inside surfaces of the cover

• Outside surfaces of the cover

• Outside surfaces of the Loader chassis

2. Use the DI water on the same areas to remove the bleach, then 
wipe them dry with a towel.

3. Dispose of used cleaning materials following biohazard 
precautions.

For any major spills of liquids down into the interior of the Loader, 
contact BD Customer Support.

More information • Performing manual system shutdown (page 61) 

Caution! Do not use a spray bottle to spray the 10% bleach 
solution because the mist can get into areas that can cause 
problems. Instead, use a squirt-type (squeeze) bottle to distribute 
the solution.

Caution! All biological specimens and materials can transmit 
potentially fatal disease. Use proper precautions and wear 
suitable protective clothing, eye wear, and gloves. Dispose of 
waste in accordance with local regulations. 
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9
Maintenance

This chapter includes the following topics:

• Maintenance overview (page 166)

• Running the daily clean procedure (page 167)

• Refilling the sheath tank (page 168)

• Emptying the waste tank (page 170)

• Performing the monthly clean procedure (page 172)

• Replacing the sheath filters (page 175)



BD FACSVerse System User’s Guide166

Maintenance overview
Introduction This topic provides a list of daily, unscheduled, and scheduled 

maintenance.

Daily maintenance Daily maintenance is part of the shutdown procedure.

Unscheduled 
maintenance

The following table lists unscheduled maintenance that you might 
have to perform.

See topics about unscheduled maintenance in the BD FACSVerse 
System Reference for information about additional maintenance 
procedures.

Scheduled 
maintenance

Scheduled maintenance should be performed according to the 
following table.

Procedure When

Running the daily clean procedure (page 167) Daily

Performing manual system shutdown (page 61) Daily

Procedure When

Refilling the sheath tank (page 168) As needed

Emptying the waste tank (page 170) As needed

Procedure When

Performing the monthly clean procedure 
(page 172)

Monthly

Replacing the sheath filters (page 175) Every 3 months
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Running the daily clean procedure
Introduction This topic describes how to run the daily clean procedure. This 

procedure is included when you perform system shutdown. You 
can also use this procedure to clean the system whenever it is 
needed.

Required materials • 2 mL of 10% bleach solution

• 3 mL of DI water

Procedure

To run the daily clean procedure:

1. From the menu bar, select Cytometer > Daily Clean. 

The following dialog opens.

2. Place a tube containing 2 mL of 10% bleach solution on the 
manual tube port, then click Continue.

Caution  Do not use the same tube repeatedly for DI water or 
bleach during the daily clean procedure. Repeated use can cause 
wear on the tube, and resulting particles can damage the tube 
sensor in the manual tube port.
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3. When prompted, place a tube containing approximately 3 mL 
of DI water on the manual tube port, then click Continue.

The dialog closes when the process is complete.

Note:  You must complete this entire procedure. If the procedure is 
interrupted or not completed, the system prevents any other 
actions from happening. This is to avoid the possibility of bleach 
remaining in the fluidics path.

More information • Fluidics components (page 24)

• Performing manual system shutdown (page 61)

Refilling the sheath tank
Introduction This topic describes how to check the sheath fluid level, illustrates 

sheath tank components, and describes how to refill the sheath 
tank.

The sheath and waste tanks must be placed at a level even with, or 
below, the cytometer. Placing the tanks higher than the cytometer 
can cause uncontrolled siphoning.

Checking the 
sheath fluid level

The standard sheath tank is translucent so you can visually check 
the fluid level. In addition, a message in the software alerts you 
when the tank is close to empty and starts a 10-minute timer. You 
must refill the tank before the 10 minutes elapses to avoid 
acquisition being interrupted. The system stops operation when the 
timer expires.

Required materials • BD FACSFlow sheath fluid to fill the sheath tank (5 L or 10 L, 
depending on which tank is being used)
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Sheath tank 
components

The following figure shows the parts of the standard sheath tank.

Procedure To refill the sheath tank:

1. Disconnect the connector from the sheath tank by turning it 
counter-clockwise.

2. Remove the sheath tank from the dock and take it to a filling 
station.

3. Remove the filler cap and fill the tank with BD FACSFlow 
sheath fluid.

Do not use sheath fluid with surfactant.

Standard sheath 
tank in dock

 Connector

Filler cap

Connector 
disconnected from 
sheath tank
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4. Re-install the filler cap and place the tank in the dock.

5. Re-install the connector and turn clockwise to tighten it.

More information • Replacing the sheath filters (page 175)

• Fluidics components (page 24)

• Emptying the waste tank (page 170)

Emptying the waste tank
Introduction This topic describes how to check the waste tank level, illustrates 

the waste tank components, and describes how to empty the waste 
tank.

The sheath and waste tanks must be placed at a level even with, or 
below, the cytometer. Placing the tanks higher than the cytometer 
can cause uncontrolled siphoning.

Checking waste 
tank level

The standard waste tank is translucent so you can visually check 
the fluid level. In addition, a message in the software alerts you 
when the tank is close to full, and starts a 10-minute timer. If the 
tank is not emptied within 10 minutes, the system prevents further 
operation.

Required materials • Enough bleach solution to equal 10% of volume of waste tank
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Waste tank 
components

The following figure shows the parts of the standard waste tank.

Procedure To empty the waste tank:

1. Verify that the system is not processing any samples. 

2. Disconnect the connector from the waste tank by turning it 
counter-clockwise.

Standard waste 
tank in dock

Filler cap

Connector

Caution! All biological specimens and materials can transmit 
potentially fatal disease. To prevent exposure to biohazardous 
agents, expose waste container contents to bleach (10% of total 
volume) before disposal. Dispose of waste in accordance with 
local regulations. Use proper precautions and wear suitable 
protective clothing, eyewear, and gloves.

Connector disconnected 
from waste tank



BD FACSVerse System User’s Guide172

3. Remove the tank from the dock and take it to a dumping 
station.

4. Remove the filler cap and empty the tank.

Hold the tank at an angle as you empty it and pour slowly to 
avoid splashing the contents.

5. Add bleach to the tank to equal 10% of the volume. 

6. Re-install the filler cap and install the tank in the dock.

7. Re-install the connector and turn clockwise to tighten it.

More information • Fluidics components (page 24)

• Refilling the sheath tank (page 168)

Performing the monthly clean procedure
Introduction This topic describes how to perform the monthly clean procedure. 

This procedure should be performed at least once per month. It can 
be performed more often if the system is heavily used or if any 
contamination is suspected.

Description The monthly clean procedure rinses the fluidics system with a 10% 
bleach solution, followed by another rinse with DI water and 
sheath fluid. The procedure takes about 20 minutes to complete.

Caution! All biological specimens and materials can transmit 
potentially fatal disease. To prevent exposure to biohazardous 
agents, expose waste container contents to bleach (10% of total 
volume) before disposal. Dispose of waste in accordance with 
local regulations. Use proper precautions and wear suitable 
protective clothing, eyewear, and gloves.
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Required materials • 2 mL of 10% bleach solution

• 3 mL of DI water

• 2 L of 10% bleach solution

• Sheath filter bypass assembly

• BD FACSFlow sheath fluid to fill the sheath tank (5 L or 10 L)

Procedure To perform the monthly clean procedure:

1. From the menu bar, select Cytometer > Monthly Clean.

The following dialog opens.

2. Load a tube with 2 mL of 10% bleach onto the manual tube 
port.

3. Fill a tank with 2 L of 10% bleach solution.

• We recommend using an extra tank dedicated for 10% 
bleach for this procedure. If you have this tank, remove the 
connector from the sheath tank and install it on the 
dedicated bleach tank.

• If you do not have a dedicated bleach tank, then empty the 
sheath fluid from the sheath tank and fill it with 10% 
bleach solution.

4. Empty the waste tank.
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5. Remove the sheath filter and store it carefully for replacement 
at the end of this procedure. See Replacing the sheath filters 
(page 175) for a figure showing the details.

a. Open the door on the left side of the chassis.

b. Disconnect the vent line on the top of the filter by 
unscrewing the connector nut.

c. Press the quick-disconnect tabs at the top and bottom of 
the filter and remove the filter from the chassis.

6. Install the sheath filter bypass assembly onto the two quick-
connects and the vent line connector. 

The bypass assembly is shown installed in the following figure.

7. Click Continue in the dialog to start the cleaning process.

A progress bar in the dialog shows the status of the process.

Caution! Installing the bypass assembly is a critical step. 
Failure to do this can damage the system.

Bypass assembly 
installed
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8. When the bleach cycle is done, remove the tube that contained 
bleach and replace it with a tube containing 3 mL of DI water.

9. Remove the bleach tank and connect the sheath tank.

• If you are using a dedicated bleach tank, disconnect it and 
install the connector on the sheath tank.

• If you are not using a dedicated bleach tank, empty any 
remaining bleach from the sheath tank, rinse it thoroughly 
with DI water, and refill it with sheath fluid.

10. Click Continue to continue the cleaning process.

A message is displayed when the process is complete, and the 
software records the time and date of the completed 
procedure.

11. Remove the bypass assembly and re-install the sheath filter. 

12. Select Cytometer > Fluidics > Purge Sheath Filter and run this 
command twice to remove any air bubbles that might have 
formed during the process.

More information • Fluidics components (page 24)

• Replacing the sheath filters (page 175)

Replacing the sheath filters
Introduction This topic describes how to replace the sheath filter on the side of 

the cytometer. It also describes how to replace the sheath supply-
line filter in the sheath tank. You should replace these filters every 
three months.

Required materials • 1 new sheath filter

• 1 new sheath supply-line filter
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Replacing the 
sheath filter

To change the sheath filter:

1. From the menu bar, select Cytometer > Shutdown to turn off 
power to the cytometer. 

2. Open the door on the left side of the chassis.

You might have to move the fluidics tanks dock if it is 
positioned next to the cytometer.

3. Disconnect the vent line on the top of the filter by unscrewing 
the connector nut.

4. Press the quick-disconnect tabs at the top and bottom of the 
filter and remove the filter from the chassis.

5. Discard the used filter.

6. Install a new filter assembly, with the flow arrow pointing up, 
by inserting each end into the connectors.

7. Reconnect the vent line on the top of the filter by screwing on 
the connector nut.

Vent line

Vent line 
connector nut

Sheath filter
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8. Select Cytometer > Fluidics > Purge Sheath Filter to bring 
sheath fluid into the new filter.

This process takes about one minute to complete. 

9. Repeat step 8 to fill the filter. 

You should see fluid in the vent line when it is done.

10. Close the door and resume normal operation.

11. Select Cytometer > Maintenance > Replace Sheath Filter.

12. Enter the information about the new filter, then click OK.

Replacing the 
sheath supply-line 
filter

The sheath supply-line filter is located inside the sheath tank in the 
tube that draws up the sheath fluid. 

To change the sheath supply-line filter:

1. Disconnect the connector from the sheath tank by turning it 
counter-clockwise.

2. Remove the base connector from the sheath tank by 
unscrewing it and pulling out the connector and supply-line 
assembly that includes the supply tube and the filter.

3. Place the connector and supply-line assembly on clean, lint-
free disposable towels so that you can work on it.

4. Twist open the supply-line filter holder and pull it apart to 
access the filter. See the following figure.

5. Remove the used filter and install a new filter.

6. Push the two halves of the filter holder back together and twist 
to close it.

Supply-line filter holderBase connector
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7. Place the supply-line assembly back into the sheath tank and 
screw on the base connector until it is secure.

More information • Fluidics components (page 24)

• Refilling the sheath tank (page 168)
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